
 

 

LEARNER GUIDE 

 

 

 

 

 

 

 

 

 

Ms PowerPoint Advanced 
 

Unit Standard 116930 

Level 3 Credits 5 
 

 



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 1 

 

 

TABLE OF CONTENTS 

TABLE OF CONTENTS ............................................................................. 1 

PERSONAL INFORMATION ..................................................................... 3 

INTRODUCTION .................................................................................... 4 

Programme methodology..................................................................................... 4 

What Learning Material you should have ............................................................... 5 

Different types of activities you can expect ........................................................... 7 

Learner Administration ........................................................................................ 8 

Assessments ...................................................................................................... 8 

Learner Support ................................................................................................. 9 

Learner Expectations ......................................................................................... 11 

UNIT STANDARD 116930 ..................................................................... 13 

INSERTING A CHART ........................................................................... 17 

What is a Chart ..................................................................................... 17 
Plotting a chart ..................................................................................... 18 

Change the layout or style of a chart .................................................................. 24 

Change the layout of chart elements .................................................................. 25 

Change the formatting style of chart elements .................................................... 26 

Work with the Excel datasheet ................................................................ 32 

Formative Assessment ...................................................................................... 35 

CREATING A DIAGRAM ........................................................................ 36 

What is a Diagram................................................................................. 37 
SmartArt.............................................................................................. 38 

When to use a SmartArt graphic ........................................................................ 38 

When to use a chart .......................................................................................... 38 

Notes re working with SmartArt ......................................................................... 38 

List of SmartArt graphics ................................................................................... 43 

Create a SmartArt graphic ................................................................................. 64 

Enter text......................................................................................................... 64 

Add shapes in your SmartArt graphic.................................................................. 65 

Delete shapes in your SmartArt graphic .............................................................. 66 

Change the colours ........................................................................................... 68 

Apply a SmartArt Style ...................................................................................... 70 

Change the color of a shape .............................................................................. 72 

Change the color of a shape border .................................................................... 74 

Change the color of an entire SmartArt graphic ................................................... 74 



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 2 

 

Create an Organisation Chart .................................................................. 76 

Modify the Structure of an Organisation Chart ..................................................... 78 

Formative Assessment ...................................................................................... 81 

CREATING A SIMPLE DRAWING ........................................................... 83 

Draw a Basic Shape ............................................................................... 85 
Add Text to an Object ............................................................................ 90 

Formative Assessment ...................................................................................... 91 

IMPORTING AND EXPORTING DATA .................................................... 92 

Insert or Paste an OLE Object ................................................................. 94 
Export Text and Slides to Microsoft Word.................................................. 96 

What are PDF and XPS formats?......................................................................... 96 

Edit or print PowerPoint handouts in Word .......................................................... 96 

Save a presentation in pdf or xps ....................................................................... 98 

Insert Slides from Other Presentations ..................................................... 99 

Formative Assessment .................................................................................... 102 

ARRANGING OBJECTS ........................................................................ 104 

Arrange and Transform Objects............................................................. 105 
Move Images and objects (Cut-And-Paste) ............................................. 109 

Formative Assessment .................................................................................... 113 

ACTION SETTINGS ............................................................................. 115 

Types of slide shows ............................................................................ 116 
Animation .......................................................................................... 119 

Add animation ................................................................................................ 120 

Specify timing ................................................................................................ 121 

Set order for an animation ............................................................................... 121 

Test your animation effect ............................................................................... 122 

Apply sound effects ............................................................................. 122 

Formative Assessment .................................................................................... 124 

MASTER SLIDES................................................................................. 125 

What Is A Master Slide......................................................................... 126 

Modify The Slide Master................................................................................... 128 

Slide Master tab.............................................................................................. 129 

Formative assessment ..................................................................................... 130 

Glossary ............................................................................................ 131 

 



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 3 

 

 

PERSONAL INFORMATION 

NAME  

CONTACT ADDRESS 
 

 

Code  

Telephone (H)  

Telephone (W)  

Cellular  

Learner Number  

Identity Number  

 

EMPLOYER  

EMPLOYER CONTACT 

ADDRESS 

 

 

Code  

Supervisor Name  

Supervisor Contact Address 
 

 

Code  

Telephone (H)  

Telephone (W)  

Cellular  

 



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 4 

 

 

INTRODUCTION 

Welcome to the learning programme 

Follow along in the guide as the training practitioner takes you through the material. 
Make notes and sketches that will help you to understand and remember what you 

have learnt. Take notes and share information with your colleagues. Important and 

relevant information and skills are transferred by sharing! 

 

 

 

 

 

 

 

This learning programme is divided into sections. Each section is preceded by a 

description of the required outcomes and assessment criteria as contained in the unit 
standards specified by the South African Qualifications Authority. These descriptions 

will define what you have to know and be able to do in order to be awarded the 

credits attached to this learning programme. These credits are regarded as building 

blocks towards achieving a National Qualification upon successful assessment and can 

never be taken away from you! 

Programme methodology 

 

 

 

 

 

 

 

 

The programme methodology includes facilitator presentations, readings, individual 

activities, group discussions and skill application exercises. 

Know what you want to get out of the programme from the beginning and start 

applying your new skills immediately.  Participate as much as possible so that the 

learning will be interactive and stimulating. 



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 5 

 

The following principles were applied in designing the course: 

✓ Because the course is designed to maximise interactive learning, you are 

encouraged and required to participate fully during the group exercises 

✓ As a learner you  will be presented with numerous problems and will be required 
to fully apply your mind to finding solutions to problems before being presented 

with the course presenter’s solutions to the problems 

✓ Through participation and interaction the learners can learn as much from each 

other as they do from the course presenter 

✓ Although learners attending the course may have varied degrees of experience 

in the subject matter, the course is designed to ensure that all delegates 

complete the course with the same level of understanding 

✓ Because reflection forms an important component of adult learning, some 

learning resources will be followed by a self-assessment which is designed so 

that the learner will reflect on the material just completed. 

This approach to course construction will ensure that learners first apply their minds 
to finding solutions to problems before the answers are provided, which will then 

maximise the learning process which is further strengthened by reflecting on the 

material covered by means of the self-assessments. 

Different role players in delivery process 

✓ Learner 

✓ Facilitator 

✓ Assessor 

✓ Moderator 

 

What Learning Material you should have 

This learning material has also been designed to provide the learner with a 

comprehensive reference guide. 

It is important that you take responsibility for your own learning process; this includes 
taking care of your learner material.  You should at all times have the following 

material with you: 

Learner Guide This learner guide is your valuable possession: 

This is your textbook and reference material, which 

provides you with all the information you will require to 

meet the exit level outcomes.  

During contact sessions, your facilitator will use this 

guide and will facilitate the learning process. During 

contact sessions a variety of activities will assist you to 
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gain knowledge and skills.  

Follow along in the guide as the training practitioner 

takes you through the material. Make notes and 

sketches that will help you to understand and 
remember what you have learnt. Take and share 

information with your colleagues. Important and 

relevant information and skills are transferred by 

sharing! 

This learning programme is divided into sections. Each 

section is preceded by a description of the required 

outcomes and assessment criteria as contained in the 
unit standards specified by the South African 

Qualifications Authority. These descriptions will define 

what you have to know and be able to do in order to 

be awarded the credits attached to this learning 
programme. These credits are regarded as building 

blocks towards achieving a National Qualification upon 

successful assessment and can never be taken away 

from you! 

Formative 

Assessment 

Workbook 

 

The Formative Assessment Workbook supports the 

Learner Guide and assists you in applying what you 

have learnt.  

The formative assessment workbook contains 
classroom activities that you have to complete in the 

classroom, during contact sessions either in groups or 

individually. 

You are required to complete all activities in the 

Formative Assessment Workbook.  

The facilitator will assist, lead and coach you through 

the process. 

These activities ensure that you understand the 

content of the material and that you get an 

opportunity to test your understanding.  
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Different types of activities you can expect 

To accommodate your learning preferences, a variety of different types of activities 

are included in the formative and summative assessments. They will assist you to 

achieve the outcomes (correct results) and should guide you through the learning 

process, making learning a positive and pleasant experience. 

 

The table below provides you with more information related to the types of activities.  

Types of Activities Description Purpose 

Knowledge Activities 

 

You are required to 
complete these 

activities on your own.  

 

 

 

 

These activities normally 
test your understanding 

and ability to apply the 

information. 

Skills Application 

Activities 

 

You need to complete 

these activities in the 

workplace  

 

 

 

These activities require 

you to apply the 

knowledge  and skills  

gained in the workplace 

Natural Occurring 

Evidence 

 

You need to collect 

information and 

samples of documents 

from the workplace. 

These activities ensure you 

get the opportunity to 

learn from experts in the 

industry. 

Collecting examples 

demonstrates how to 

implement knowledge and 

skills in a practical way 
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Learner Administration  

 

 

 

 

Attendance Register 

You are required to sign the Attendance Register every day you attend training 

sessions facilitated by a facilitator.  

Programme Evaluation Form  

On completion you will be supplied with a “Learning programme Evaluation Form”. 

You are required to evaluate your experience in attending the programme. 

Please complete the form at the end of the programme, as this will assist us in 
improving our service and programme material.  Your assistance is highly 

appreciated. 

Assessments 

The only way to establish whether a learner is competent and has accomplished the 

specific outcomes is through the assessment process.  Assessment involves collecting 

and interpreting evidence about the learners’ ability to perform a task. 

To qualify and receive credits towards your qualification, a registered Assessor will 

conduct an evaluation and assessment of your portfolio of evidence and 

competency. 

This programme has been aligned to registered unit standards.  You will be 

assessed against the outcomes as stipulated in the unit standard by completing 
assessments and by compiling a portfolio of evidence that provides proof of your 

ability to apply the learning to your work situation. 
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How will Assessments commence? 

Formative Assessments  

The assessment process is easy to follow. You will be guided by the Facilitator. Your 

responsibility is to complete all the activities in the Formative Assessment Workbook 

and submit it to your facilitator.  

Summative Assessments  

You will be required to complete a series of summative assessments. The Summative 

Assessment Guide will assist you in identifying the evidence required for final 
assessment purposes. You will be required to complete these activities on your own 

time, using real life projects in your workplace or business environment in preparing 

evidence for your Portfolio of Evidence. Your Facilitator will provide more details in this 

regard. 

To qualify and receive credits towards your qualification, a registered Assessor will 

conduct an evaluation and assessment of your portfolio of evidence and 

competency. 

Learner Support 

The responsibility of learning rests with you, so be proactive and ask questions and 

seek assistance and help from your facilitator, if required. 

 

 

 

 

 

 

 

 

Please remember that this Skills Programme is based on outcomes based education 

principles which implies the following: 

✓ You are responsible for your own learning – make sure you manage your study, 

research and workplace time effectively.  

✓ Learning activities are learner driven – make sure you use the Learner Guide 

and Formative Assessment Workbook in the manner intended, and are familiar 

with the workplace requirements.   

✓ The Facilitator is there to reasonably assist you during contact, practical and 
workplace time for this programme – make sure that you have his/her contact 

details. 
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✓ You are responsible for the safekeeping of your completed Formative 

Assessment Workbook and Workplace Guide  

✓ If you need assistance please contact your facilitator who will gladly assist you. 

✓ If you have any special needs please inform the facilitator  
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Learner Expectations  

Please prepare the following information. You will then be asked to introduce yourself 

to the instructor as well as your fellow learners 

 

 

 

 

 

Your name:  

 

 

The organisation you represent:  

 

 

Your position in organisation:  

 

 

What do you hope to achieve by attending this course / what are your course 

expectations? 
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UNIT STANDARD 116930 

Unit standard title 

Use a Graphical User Interface (GUI)-based presentation application to enhance 

presentation appearance  

NQF Level 

3 

Credits 

5 

Purpose 

This unit standard is intended for people who need to enhance presentation 

appearance using a Graphical User Interface (GUI)-based presentation application 

either as a user of computers or as basic knowledge for a career in the ICT industry. 

The performance of all elements is to a standard that allows for further learning in this 

area 

Learning assumed to be in place 

The credit value of this unit standard is calculated assuming a person has the prior 

knowledge and skills to:  

✓ Read, write, communicate and comprehend at least at GET level 

✓ Use generic functions in a Graphical User Interface (GUI)-environment 

✓ Use a Graphical User Interface (GUI)-based presentation application to create 

and edit slide presentations 

✓ Use a Graphical User Interface (GUI)-based presentation application to prepare 

and produce a presentation according to a given brief.  

Unit standard range 

✓ This standard is applicable to any presentation application that runs on any 

Graphical User Interface(GUI) operating systems 

✓ Where wording is not exact for the chosen operating system, the learner can 

choose the equivalent item or option to demonstrate competence in the specific 

outcome or assessment criteria 

✓ Appearance enhanced by the use of chart graphs, drawn objects, images, 

objects 

Specific outcomes and assessment criteria 

Specific outcome 1: Create a chart/graph in a presentation 
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Assessment criteria 

✓ A new chart/graph is created 

✓ Data is entered into the chart graph 

✓ Chart/graph colours are changed.  Chart/graph area, data series 

✓ The chart/graph type is changed 

✓ Chart/graphs are resized 

Specific outcome 2: Create an organisational chart in a presentation 

Assessment criteria 

✓ A new organisational chart is created.  Minimum of three levels and hierarchical 

elements 

✓ The hierarchical structure of an organisational chart is changed 

✓ Hierarchical elements are added and removed: Subordinate, co-worker, 

manager 

✓ The organisational chart is resized 

Specific outcome 3: Create a drawing in a presentation 

Assessment criteria 

✓ Lines are drawn into a presentation: Straight line, arrow line, curve line, 

freeform line 

✓ Line attributes are changed: Style, arrow start and finish, colour, width 

✓ Shapes are drawn into a presentation: At least two of: Box, circle, autoshape 

✓ The orientation of a drawing is changed 

✓ The attributes of a shape are changed: Any three of: line colour, fill colour, 3-D 

✓ Drawings are resized: Resize entire drawing 

✓ Drawing objects are re-aligned in the presentation: At least one of: 

automatically, manually 

✓ The order of display of overlapping objects is changed relative to the other 

drawing objects 

✓ Connector lines are added between shapes 

Specific outcome 4: Import images into a presentation 

Assessment criteria 

✓ Images are imported from different file types: File types: JPEG, WMF, BMP 

✓ Images are resized: Resize entire image, crop image 

✓ An image is copied to a master slide 

Specific outcome 5: Images and objects are manipulated in presentation: 

Chart/graphs, organisational charts, drawing objects 

Assessment criteria 

✓ Images and objects are moved 
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✓ Images and objects are copied 

✓ Images and objects are deleted 

✓ Images and objects are manipulated: Flip and rotate images 

Specific outcome 6: Animation effects and transitions are applied or added to a 

presentation.  

Assessment criteria 

✓ Animation effects are applied to the presentation: At least 3 of the following: 

Animation effects, timing, sounds, sequence, automatic, manual 

✓ Slide transition effects and timing are added to a presentation: At least 2 of the 

following:Transition effects, timing, sounds, automatic, manual 



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 16 

 

Specific outcome 7: Master Slides are customised within a presentation  

Assessment criteria 

✓ An item is copied to a master slide: Item: Any one of drawing object, image, 

object 

✓ Formatting is changed: At least 4 of the following:Font, style, size, colour, 

alignment, bullets, numbering, line spacing, character spacing, headers, 

footers, background. 

Critical cross field outcomes 

✓ Organise and manage oneself and one`s activities responsibly and effectively.  

✓ Collect, analyse, organise, and critically evaluate information 

✓ Communicate effectively using visual, mathematical and/or language skills in 

the modes of oral and/or written persuasion when engaging with the subject 

✓ Use science and technology effectively and critically, showing responsibility 

towards the environment and health of others 
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INSERTING A CHART 

Outcome  

Create a chart/graph in a presentation 

Assessment criteria 

✓ A new chart/graph is created 

✓ Data is entered into the chart graph 

✓ Chart/graph colours are changed.  Chart/graph area, data series 

✓ The chart/graph type is changed 

✓ Chart/graphs are resized 

What is a Chart 
A chart (or graph) is a diagram displaying the relationship between numeric data. 

Charts make it easier to identify, present, and emphasise trends, highs and lows, or 

comparisons in data, especially to an audience who may not be familiar with the 

source data. A chart can be a lot more convincing in support of an argument than a 

table of numbers.  

 

 

 
Column Chart 

There are a variety of chart formats (or types), such as Line, Bar, and Pie charts, 
which can all be presented in 2-D or 3-D layout. Chart elements can be customised for 

colour, font, size, scale and in various other ways. Bars on a chart can be displayed in 

a variety of shapes including blocks, columns, cones, and pyramids. 

Excel has its own chart-creation tool and is an ideal application in which to create, 
edit, and format charts. You can copy and paste an Excel chart to another file, such as 

a Word document or PowerPoint presentation. 
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If you do not have Excel, you can use Microsoft Graph to create and edit a chart. 

Graph is a chart-editing application shared between all the Office applications. 

Office uses Object Linking and Embedding (OLE) to embed a Microsoft Graph object in 

the Office "host" document. You can edit the chart object at any time using the tools 

available in Graph. 

Plotting a chart 
Data for a chart generally needs to be laid out in a table, spreadsheet, or delimited 

list, with column and row headings. 

You do not have to select all the data from the table however. For example, the 

following selection (in an Excel spreadsheet) could be made to compare how profits 

changed over time for different items. The Totals are not required. 

 

 
Data selection for a column or bar chart 

 

Bar, column, and line charts are made up of the data series (the values that are 

plotted), the value axis (displaying the range of values in the data series), and the 

category axis (displaying the range of items providing the values). 

In this example, the series legend comes from the row headings (John, Mike, Jim, 

Paul), the categories are Jan, Feb, Mar, and the values to plot range from 125 to 295. 

 

Tip Data for a Graph chart is stored in a datasheet attached to 

the chart. You can include or exclude rows and columns 

temporarily if you only want to show a portion of the data set 

in the chart. 
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Column chart 

 

Alternatively, you could select separate areas of the table to show how much of the 

total profit each item comprises. 

An appropriate chart to display this data would be the pie chart, which is designed to 

show how elements of one data series make up a total.  

  

  
Data selection for a pie chart 

 
Pie chart 

 

You could also use a column chart to compare the totals with one another. 

For most charts, you need to restrict the number of data series plotted or the chart 
will become too confusing - imagine the column chart shown above with 50 different 

columns drawn on it! 

Chart type 

One of the main decisions to make is to choose the chart type. Some of the most 

commonly used types are: 

✓ Bar and column - display discrete coloured horizontal bars or vertical columns 
to represent each value. This type of chart makes it easy to compare values, 

because very high or low values stand out. Bar charts are better suited to 

displaying a large number of different items (or series) than column charts - 

the emphasis is more on the values than the items themselves. 

 

Value (Y) axis 

Data points for 
different series 

Category (X) axis 

Series legend 
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Bar Chart Column Chart 

✓ Line - plot each value with a small marker and add a line to join the markers 

up. Line charts emphasise changes in data over a regular period (trends), 

particularly where there are highs and lows. Line charts should not be used with 

too many series, as they become too confusing to read. However, they are 

useful when a category contains many values. 

 

 
Line Chart 

 

✓ Area - plot each series of values as a line without markers. The area under the 

line is filled in. Area charts emphasise the rate of change rather changes in 

discrete values. Stacked area charts (where the lines are plotted on top of one 

another) make it easy to see how much an item contributes to the total amount 

of values plotted. 

 

 

Area Chart 

 

✓ Pie - display each value as a slice of a circle, which represents the total of all 

values plotted. This shows how much one element contributes to the overall 

amount in comparison with other elements.  
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Pie Chart 

 

Each main chart type also has several subtypes or variations, such as adding a 3-D 

effect.  

Insert a Chart using Microsoft Graph 

You can create a Graph by inserting a Graph object into your or PowerPoint slide. 

Graph creates a default chart with some sample data. You can then adjust the data to 

the values you want to use and, optionally, change the chart type to something more 

suitable.  

✓ On the Insert tab, go to the illustrations group and click Insert Chart  
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The insert chart dialogue box will display 

 

When you rest the mouse pointer over any chart type, a ScreenTip displays its name. 

Select the chart you need.  

OR 

✓ On the Home tab, slides group, select Layout 
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✓ Select a slide layout that includes the illustrations group and click on Chart. 

✓ A new Microsoft Graph chart object is created. Graph's menus and toolbars are 

displayed. 

✓ MS Excel is also opened.  Now you can edit the data  

✓ Enter the data you need for your chart and when you are finished editing your 

data, you can close Excel.  
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SAMPLE DATA IN AN EXCEL WORKSHEET 

 

 

 

To get a good idea of what you can add to or change in your chart, under Chart Tools, 

click the Design, Layout, and Format tabs, and then explore the groups and options 

that are provided on each tab 

The Design tab gives you the following options: 

✓ Change chart type: here you can change to a different chart type 

✓ Switch row/columns: the data in rows will now be displayed in columns  

✓ Edit data: opens Excel so that you can edit the data 

✓ Quick layout: change the layout of the chart 

The Chart Styles group shows different options for the look of the chart. 

Change the layout or style of a chart 

Once you have created your chart, Microsoft allows you to change its look. To avoid a 
lot of manual formatting, Microsoft Office Excel provides a variety of useful predefined 

quick layouts and styles that you may want to apply to your chart.  
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You can then customise the chart further by manually changing the layout and 

formatting style of its individual chart elements. 

Select a predefined chart style 

✓ Click the chart that you want to format. The Chart Tools, adding the Design, 

Layout, and Format tabs will display 

✓ On the Design tab, in the Chart Styles group, click the chart style that you want 

to use. 

✓ To see all predefined chart styles, click More . 

 

Tip Chart styles use the colors of the current document theme 

that is applied to the workbook. You can change the colors by 
switching to a different document theme. You can also 

customize a document theme to display a chart in the exact 

colors that you want. 

Change the layout of chart elements  

Click anywhere in the chart or click the chart element that you want to change. 

This displays the Chart Tools, adding the Design, Layout, and Format tabs. 

On the Layout tab, do one or more of the following: 

In the Labels group, click a layout option for the 

chart label that you want to change. 

 

 

 

In the Axes group, click a layout option for the axis or gridlines 

that you want to change.  

 

 

 

 

 

In the Background group, click a layout option for the 

background that you want to change. 
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Note Options for chart walls, floors, and 3-D rotation are available 

on 3-D charts only. 

 

In the Analysis group, click a layout option for any lines or bars that you want to add 

or change. Depending on the chart type of your chart, some analysis options may or 

may not be available. 

Note The layout options that you select are applied to the element 

that you have selected. For example, if you have the whole 

chart selected, data labels will be applied to all data series. 

If you have a single data point selected, data labels will only 

be applied to the selected data series or data point. 

Tips 

✓ On the Layout tab, you can also find options to add pictures, shapes, or text 

boxes (Insert group), and you can change the name of your chart (Properties 

group). 

✓ To change the format of a specific chart element, you can right-click that chart 

element, and then click Format Chart element. 

Change the formatting style of chart elements 

Click the chart element that you want to change or do the following to select it from 

a list of chart elements: 

✓ Click the chart. This displays the Chart Tools, adding the Design, Layout, 
and Format tabs. 

✓ On the Format tab, in the Current Selection group, click 

the arrow in the Chart Elements box, and then click the 

chart element for which you want to change the formatting 

style. 

✓ On the Format tab, do one of the following: 

✓ In the Current Selection group, click Format Selection, and then  

✓ In the Format Chart element dialog box, select the formatting options that 

you want. 

✓ In the Shape Styles group, click the 

More button , and then select a style. 
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✓ In the Shape Styles group, click Shape Fill, Shape Outline, or Shape 
Effects and then select the formatting options that you want. 

✓ In the WordArt Styles group, click a WordArt Style option, or click Text 

Fill, Text Outline, or Text Effects, and then select the text formatting 

options that you want. 

Tip To change the format of a specific chart element, you can 

right-click that chart element, and then click Format Chart 

element. 

 

Move, Resize, Edit, and Delete a Graph Object 

You work with a graph object as you would a picture object. 

Position a chart 

An embedded chart can be moved and positioned like any other object. 

✓ To move a chart, click-and-drag the object around the slide/page 

OR 

✓ Use the Cut  and Paste  tools 

Resize a chart 

To resize individual elements of the chart, you must edit it in Graph. However, you 

can scale the chart object itself in the normal way. 

✓ Click the chart to select it 

✓ Click-and-drag the handles on the border 

 

OR 

✓ From the Format 
tab, size group 

then click the Size 
arow and adjust the 

Height and Width 

properties 
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Edit a chart 

✓ Double-click the chart object.  The appropriate Format Chart dialogue box will 

display 

OR 

✓ Right-click the chart object for the shortcut menu to appear 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

✓ Select the function you require 

✓ Graph's toolbars and menus will replace those of PowerPoint. 

✓ Use the Graph menu and toolbars to edit and format the chart 

✓ Edit the Datasheet to change the values used in the chart 

✓ Click outside of the embedded object to re-embed the updated chart into the 

host document 

Delete a chart object 

✓ Click once on the chart to select it then press Delete  

Move around the datasheet 
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Whenever you select an option to edit chart elements, Excel will open to display the 

datasheet. 

Used the following options to move around the datatsheet: 

Press To Move 

        One cell 

Home  To beginning of row 

Ctrl + Home  To first data cell 

End  To end of row 

Ctrl + End  To lower-right cell containing 

data 

Page Down  Down one window 

Page Up  Up one window 

 

Tip Alternatively, you can click the cell you want to move to with 

your mouse to move around the datasheet. Use the scroll bars 
to scroll through the datasheet. Scrolling changes only the 

screen display; the active cell and current selection do not 

change. 



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 30 

 

 

Select cells, rows, and columns 

There is always at least one cell selected on the datasheet: this is the active cell. To 

change the active cell, select the one you want to be active. 

 

To Select Click 

One cell The cell 

Range of cells And-drag from one corner of 

the range to the opposite 

corner 

Row or 

column 

Click the row or column 

heading 

All cells Click the Select All button (the 

column button above the row 

labels) 

 

Enter and edit data 

The first column and the first row are normally used as labels to identify the data.  

✓ Select a cell and start typing then move off the cell (SpeedKey: Enter ) to 

finish 

OR 

✓ Double-click a cell 

The cell is activated with an insertion point so you can edit the data directly in the 

cell.  

✓ Move the insertion point to where you want to change the data and make the 

change you want 

✓ Press Enter  to make the entry 

OR 

✓ Select a cell and press F2  

The cell is activated with an insertion point so you can edit the data directly in the 

cell.  
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✓ Move the insertion point to where you want to change the data and make the 

change you want 

✓ Press Enter  to make the entry 
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Work with the Excel datasheet 

Delete data 

On the datasheet, you can remove data from cells, formatting from cells or both data 

and formatting from cells.  

✓ Select the cell(s) containing the data you want to delete 

✓ On the Home tab, from the Editing group menu, select Clear 

✓ Select All to remove both the formatting and the data; Contents to remove 

only the data; or Formats to remove the formatting but not the data 

 

 

 

 

 

 

 

 

 

 

 

Note Cleared data is not put onto the Clipboard. You can recover 

cleared data by choosing Undo from the Edit menu before you 

choose any other commands. 

Delete rows and columns 

✓ In the datasheet, select the rows or columns you want to delete 

You can select several rows or columns by dragging across several row or column 

headings. 

✓ From the Edit menu, select Delete 

Warning If you do not select entire columns or rows before 

choosing Delete, a dialogue box appears. Specify whether you 

want cells shifted left or up, and whether you want to delete 

entire rows or entire columns. 
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Insert rows and columns 

✓ Select the number of rows or columns you want to insert 

For example, if you want to insert one column, select one column; if you want to 

insert three rows, select three rows. 

 

Tip You can select several rows or columns by dragging across 

several row or column headings. 

✓ From Home tab, Cells group, select  Insert menu 

✓ Select Cells (or make another selection) 

 

Format data 

✓ Select the cell(s) to format 

✓ Use the groups and buttons on the Home tab, Numbers group to apply 

numeric formats, such as Currency , Percent Style , Comma Style 

, or Increase Decimal  or Decrease Decimal  
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Formative Assessment 

✓ Start a new PowerPoint presentation file 

✓ Save the file as MANUFACTURER CAR SALES 

✓ Add the heading Car Sales; change the slide type to a Title and Content slide 

and add the title Car Sales 

✓ Insert a new column chart  

✓ Click in the datasheet and type the following labels in the first row, replacing 

the existing cell contents: Vauxhall, BMW, Rover, Ford 

✓ Click in row 4 in the first column and add the label South 

✓ Change the values in the cells as shown below 

 

 

 

✓ Save changes to the file 

✓ Print a single copy of the page/slide containing the chart 

✓ Double-click the chart to edit it 

✓ Click the chart object to select it then on the Standard toolbar, click Copy  

✓ Insert a new page/slide then paste the copied chart on to it 

✓ Double-click the copied chart to edit it 

✓ Change the chart to a Pie Chart 

✓ Save the file and close it 
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CREATING A DIAGRAM 

 

 

Outcome  

Create an organisational chart in a presentation 

 

 

Assessment criteria 

✓ A new organisational chart is created.  Minimum of three levels and hierarchical 

elements 

✓ The hierarchical structure of an organisational chart is changed 

✓ Hierarchical elements are added and removed: Subordinate, co-worker, 

manager 

✓ The organisational chart is resized 
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What is a Diagram 
A diagram displays relationships between different elements in a visual way. Different 

types of diagram are best suited to displaying different types of relationships.  

Hierarchy 

A hierarchy shows how an element relates to other elements within the group in terms 

of responsibility, control, or precedence. Typically elements higher in the hierarchy 
have more authority or control than elements lower in the hierarchy. A good example 

of a hierarchical diagram is one showing the employees working for a business. An 

organisation chart emphasises the individual elements (for example, workers) and 

their relationships. A pyramid diagram shows layers of precedence (for example, 

different departments). 

Process 

Process diagrams show how elements contribute towards an end result. In a target 

diagram, the elements are shown in layers. In a radial diagram they are shown as 

spokes radiating from the result element. In a cycle diagram, there is no actual end 
result, because the process is continuous, with the last element feeding into the first. 

A process can also be shown by drawing a flowchart. Flowcharts can be created using 

the Office connector shape tools. 

Commonality 

Diagrams are also useful for showing what elements share in common (and how they 

are different). A Venn diagram (as used for sets in mathematics) shows what 

elements have a property in common. A radial diagram can be used to show the 

components of a source element. 

In PowerPoint 2010, SmartArt allows you create diagrams 
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SmartArt 

Tip A SmartArt graphic is a visual representation of information 

and ideas 

A chart is a visual illustration of numeric values or data.  

We can therefore say that SmartArt graphics are designed for text and charts are 

designed for numbers. 

When to use a SmartArt graphic 

A SmartArt graphic will help you if you want to do any of the following: 

✓ Create an organization chart. 

✓ Show a hierarchy, such as a decision tree. 

✓ Illustrate steps or stages in a process or workflow. 

✓ Show the flow of a process, procedure, or other event. 

✓ List information. 

✓ Show cyclical or repetitive information. 

✓ Show a relationship between parts, such as overlapping concepts. 

✓ Create a matrix illustration. 

✓ Show proportional or hierarchical information in a pyramid illustration. 

✓ Create an illustration quickly by typing or pasting your text and having it 

automatically positioned and arranged for you. 

When to use a chart 

A chart is appropriate if you want to do any of the following: 

✓ Create a bar chart or column chart. 

✓ Create a line or XY scatter (data point) chart. 

✓ Create a stock chart, used to graph various stock prices. 

✓ Create a surface, donut, bubble, or radar chart. 

✓ Link to live data in a Microsoft Excel workbook. 

✓ Update your chart automatically when numbers in a Microsoft Excel workbook 

are updated. 

✓ Use "what-if" calculations, and you want to be able to change numbers and see 

the changes automatically and immediately reflected in the chart. 

✓ Automatically add legends or gridlines that are based on your data. 

✓ Use chart-specific functionality, such as error bars or data labels. 

Notes re working with SmartArt 
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When you create a SmartArt graphic, you are prompted to choose a type of SmartArt 

graphic, such as  

✓ Process,  

✓ Hierarchy,  

✓ Cycle, or  

✓ Relationship. 

Each type of SmartArt graphics contains several different layouts.  

After you choose a layout, it is easy to switch the layout or type of a SmartArt 
graphic. Most of your text and other content, colors, styles, effects, and text 

formatting are automatically carried over to the new layout. 

As you add and edit your content in the Text pane, your SmartArt graphic is 

automatically updated — shapes are added or removed as needed. 

What to consider when you create a SmartArt graphic 

Before you create your SmartArt graphic, decide what type and layout are best for 

displaying your data.  

What message do you want to send with your SmartArt graphic? Do you want a 
certain look? Since you can quickly and easily switch layouts, try different layouts 

(across types) until you find the one that best illustrates your message. Your graphic 

should be clear and easy to follow. Experiment with different types by using the table 
below as a starting point. The table is intended to help you get started and is not an 

exhaustive list. 

Purpose of graphic Graphic 

type 

Show non-sequential information List  

Show steps in a process or timeline Process  

Show a continual process Cycle  

Show a decision tree Hierarchy  

Create an organization chart Hierarchy 

Illustrate connections Relationship 

Show how parts relate to a whole Matrix 
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Show proportional relationships with the largest component on the top 

or bottom  
Pyramid 

Draw a family tree with pictures Picture 

Also, consider the amount of text that you have, because the amount of text often 

determines the layout that you use and how many shapes you need in the layout. 

In general, SmartArt graphics are most effective when the number of shapes and the 

amount of text are limited to key points. Larger amounts of text can distract from 

the visual appeal of your SmartArt graphic and make it harder to convey your 

message visually.  
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Some layouts, such as Trapezoid List in the List type, work well with larger 

amounts of text. 

 

 

 

Some layouts for SmartArt graphics contain a fixed number of shapes. For example, 

the Opposing Arrows layout in the Relationship type is designed to show two opposing 

ideas or concepts. Only two shapes can correspond to text, and the layout cannot be 

changed to display more ideas or concepts. 

 

THE OPPOSING ARROWS LAYOUT WITH TWO OPPOSING IDEAS 

If you need to convey more than two ideas, switch to another layout that has more 

than two shapes for text, such as the Basic Pyramid layout in the Pyramid type. Keep 

in mind that changing layouts or types can alter the meaning of your information. For 
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example, a layout with arrows pointing to the right, such as Basic Process in the 

Process type, has a different meaning from a SmartArt graphic with arrows going in a 

circle, such as Continuous Cycle in the Cycle type. 
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List of SmartArt graphics 

This section is included for your information only 

List 

Layout name Description Picture 

Alternating 

Hexagon List 

Use to represent a series of interconnected ideas. Level 1 text 

appears inside the hexagons. Level 2 text appears outside the shapes. 

 

Basic Block 

List 

Use to show non-sequential or grouped blocks of information. 

Maximizes both horizontal and vertical display space for shapes. 

 

Bending 

Picture 

Accent List 

Use to show non-sequential or grouped blocks of information. The 

small circular shapes are designed to contain pictures. Works well for 

illustrating both Level 1 and Level 2 text. Maximizes both horizontal 

and vertical display space for shapes. 

 

Continuous 

Picture List 

Use to show groups of interconnected information. The circular shapes 

are designed to contain pictures. 

 

Descending 

Block List 

Use to show groups of related ideas or lists of information. The text 

shapes decrease in height sequentially, and the Level 1 text displays 

vertically. 

 

Detailed 

Process 

Use with large amounts of Level 2 text to show a progression through 

stages. 

 

Grouped List Use to show groups and sub-groups of information, or steps and sub-
steps in a task, process, or workflow. Level 1 text corresponds to the 

top-level horizontal shapes, and Level 2 text corresponds to vertical 

sub-steps under each related top-level shape. Works well for 

emphasizing sub-groups or sub-steps, hierarchical information, or 

multiple lists of information.  
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Hierarchy List Use to show hierarchical relationships progressing across groups. Can 

also be used to group or list information. 

 

Horizontal 

Bullet List  

Use to show non-sequential or grouped lists of information. Works 

well with large amounts of text. All text has the same level of 

emphasis, and direction is not implied. 

 

Horizontal 

Picture List 

Use to show non-sequential or grouped information with an emphasis 

on related pictures. The top shapes are designed to contain pictures.  

 

Increasing 

Circle Process 

Use to show a series of steps, with the interior of the circle increasing 

with each step. Limited to seven Level 1 steps but unlimited Level 2 
items. Works well with large amounts of Level 2 text. 

 

Lined List Use to show large amounts of text divided into categories and 

subcategories. Works well with multiple levels of text. Text at the 

same level is separated by lines. 

 

Opposing 

Ideas 

Use to show two opposing or contrasting ideas. Can have one or two 

Level 1 items. Each Level 1 text can contain multiple sub-levels. 

Works well with large amounts of text. 

 

Picture 

Accent List 

Use to show grouped or related information. The small shapes on the 

upper corners are designed to contain pictures. Emphasizes Level 2 

text over Level 1 text, and is a good choice for large amounts of Level 
2 text. 

 

Picture 

Caption List  

Use to show non-sequential or grouped blocks of information. The top 

shapes are designed to contain pictures and pictures are emphasized 

over text. Works well for pictures with short text captions. 

 

Pie Process Use to show steps in a process with each pie slice increasing in size 

up to seven shapes. Level 1 text displays vertically. 
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Plus and 

Minus 

Use to show the pros and cons of two ideas. Each Level 1 text can 

contain multiple sub-levels. Works well with large amounts of text. 

Limited to two Level 1 items. 

 

Pyramid List Use to show proportional, interconnected, or hierarchical 

relationships. Text appears in the rectangular shapes on top of the 

pyramid background. 

 

Reverse List Use to change between two items. Only the first two items of text 

display, and each item can contain a large amount of text. Works well 

to show a change between two items or shift in order. 

 

Segmented 

Process 

Use to show a progression or sequential steps in a task, process, or 

workflow. Emphasizes Level 2 text, since each line appears in a 
separate shape. 

 

Stacked List Use to show groups of information or steps in a task, process, or 

workflow. Circular shapes contain Level 1 text, and the corresponding 

rectangles contain Level 2 text. Works well for numerous details and 

minimal Level 1 text. 

 

Square 

Accent List 

Use to show lists of information divided into categories. Level 2 text 

appears beside a small square shape. Works well with large amounts 

of Level 2 text. 

 

Table 

Hierarchy 

Use to show groups of information built from top to bottom, and the 

hierarchies within each group. This layout does not contain connecting 

lines.  

 

Table List Use to show grouped or related information of equal value. The first 

Level 1 line of text corresponds to the top shape and its Level 2 text 

is used for the subsequent lists. 

 

Target List Use to show interrelated or overlapping information. Each of the first 

seven lines of Level 1 text appears in the rectangular shape. Unused 
text does not appear, but remains available if you switch layouts. 

Works well with both Level 1 and Level 2 text. 
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Trapezoid List  Use to show grouped or related information of equal value. Works well 

with large amounts of text. 

 

Vertical Box 

List 

Use to show several groups of information, especially groups with 

large amounts of Level 2 text. A good choice for bulleted lists of 

information. 

 

Vertical Block 

List 

Use to show groups of information or steps in a task, process, or 

workflow. Works well with large amounts of Level 2 text. A good 

choice for text with a main point and multiple sub-points. 

 

Vertical Bullet 

List 

Use to show non-sequential or grouped blocks of information. Works 

well for lists with long headings or top-level information. 

 

Vertical 

Chevron List 

Use to show a progression or sequential steps in a task, process, or 

workflow, or to emphasize movement or direction. Emphasizes Level 

2 text over Level 1 text, and is a good choice for large amounts of 

Level 2 text. 

 

Vertical 

Picture 

Accent List 

Use to show non-sequential or grouped blocks of information. The 

small circles are designed to contain pictures. 

 

Vertical 

Picture List 

Use to show non-sequential or grouped blocks of information. The 

small shapes on the left are designed to contain pictures. 

 

Vertical 

Accent List 

Use to show lists of information. Level 2 text appears in rectangular 

shapes over vertical chevrons. Emphasizes Level 2 text over Level 1 

text, and is a good choice for medium amounts of Level 2 text. 

 

Vertical Arrow 

List 

Use to show a progression or sequential steps in a task, process, or 

workflow that move toward a common goal. Works well for bulleted 
lists of information. 
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Vertical Circle 

List 

Use to show sequential or grouped data. Works best for Level 1 text, 

which displays next to a large circular shape. Lower levels of text are 

separated with smaller circular shapes. 

 

Vertical 

Curved List 

Use to show a curved list of information. To add pictures to the accent 

circle shapes, apply a picture fill. 

 

Process 

Layout name Description Picture 

Accent 
Process 

Use to show a progression, a timeline, or sequential steps in a 
task, process, or workflow. Works well for illustrating both Level 1 

and Level 2 text. 

 

Alternating 

Flow 

Use to show groups of information or sequential steps in a task, 

process, or workflow. Emphasizes the interaction or relationships 

among the groups of information. 

 

Arrow Ribbon Use to show either related or contrasting concepts with some 

connection, such as opposing forces. The first two lines of Level 1 

text are used for text in the arrows. Unused text does not appear, 

but remains available if you switch layouts.  

 

Basic 

Bending 
Process 

Use to show a progression or sequential steps in a task, process, 

or workflow. Maximizes both horizontal and vertical display space 
for shapes. 

 

Basic 

Chevron 

Process 

Use to show a progression; a timeline; sequential steps in a task, 

process, or workflow; or to emphasize movement or direction. 

Level 1 text appears inside an arrow shape while Level 2 text 

appears below the arrow shapes.  

 

Basic Process Use to show a progression or sequential steps in a task, process, 

or workflow. 
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Basic 

Timeline 

Use to show sequential steps in a task, process, or workflow, or to 

show timeline information. Works well with both Level 1 and Level 

2 text. 

 

Chevron List Use to show a progression through several processes that make 

up an overall workflow. Also works for illustrating contrasting 

processes. The Level 1 text corresponds to the first arrow shape 

on the left, while the Level 2 text corresponds to horizontal sub-
steps for each shape that contains Level 1 text. 

 

Circular 

Bending 

Process 

Use to show a long or non-linear sequence or steps in a task, 

process, or workflow. Works best with Level 1 text only. 

Maximizes both horizontal and vertical display space for shapes.  

 

Closed 

Chevron 

Process 

Use to show a progression, a timeline, or sequential steps in a 

task, process, or workflow, or to emphasize movement or 

direction. Can be used to emphasize information in the starting 

shape. Works best with Level 1 text only. 

 

Circle Accent 

Timeline 

Use to show a series of events or timeline information. Level 1 

text appears next to larger circular shapes. Level 2 text appears 
next to smaller circular shapes. 

 

Circle Arrow 

Process 

Use to show sequential items with supporting text for each item. 

This diagram works best with small amounts of Level 1 text. 

 

Continuous 
Arrow 

Process 

Use to show a timeline or sequential steps in a task, process, or 
workflow. Works best with Level 1 text because each line of Level 

1 text appears inside the arrow shape. Level 2 text appears 

outside the arrow shape.  

 

Continuous 

Block Process 

Use to show a progression or sequential steps in a task, process, 

or workflow. Works best with minimal Level 1 and Level 2 text. 

 

Continuous 

Picture List 

Use to show groups of interconnected information. The circular 

shapes are designed to contain pictures. 
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Converging 

Arrows 

Use to show ideas or concepts that converge to a central point. 

Works best with Level 1 text only.  

 

Descending 

Process 

Use to show a descending series of events. The first Level 1 text 

is at the top of the arrow, the last Level 1 text displays at the 

bottom of the arrow. Only the first seven Level 1 items appear. 

Works best with small to medium amounts of text. 

 

Detailed 

Process 

Use with large amounts of Level 2 text to show a progression 

through stages. 

 

Diverging 

Arrows 

Use to show ideas or concepts that progress outward from a 

central source. Works best with Level 1 text only. 

 

Equation Use to show sequential steps or tasks that depict a plan or result. 

The last Level 1 line of text appears after the equals sign 

(=).Works best with Level 1 text only. 

 

Funnel Use to show the filtering of information or how parts merge into a 

whole. Emphasizes the final outcome. Can contain up to four lines 

of Level 1 text; the last of these four Level 1 text lines appears 

below the funnel and the other lines correspond to a circular 

shape. Unused text does not appear, but remains available if you 

switch layouts.  

Gear Use to show interlocking ideas. Each of the first three lines of 

Level 1 text corresponds to a gear shape, and their corresponding 
Level 2 text appears in rectangles next to the gear shape. Unused 

text does not appear, but remains available if you switch layouts. 

 

Increasing 

Arrows 

Process 

Use to show sequential and overlapping steps in a process. 

Limited to five Level 1 items. Level 2 can contain large amounts 

of text. 

 

Opposing 

Arrows 

Use to show two opposing ideas, or ideas that diverge from a 

central point. Each of the first two lines of Level 1 text 

corresponds to an arrow. Unused text does not appear, but 

remains available if you switch layouts.  
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Phased 

Process 

Use to show three phases of a process. Limited to three Level 1 

items. The first two Level 1 items can each contain four Level 2 

items, and the third Level 1 item can contain an unlimited number 

of Level 2 items. Works best with small amounts of text. 

 

Picture 

Accent 

Process 

Use to show sequential steps in a task, process, or workflow. The 

rectangular shapes in the background are designed to contain 

pictures. 

 

Process 

Arrows 

Use to show information illustrating a process or workflow. Level 

1 text appears in the circular shapes and Level 2 text appears in 

the arrow shapes. Works best for minimal text and to emphasize 

movement or direction. 

 

Process List Use to show multiple groups of information or steps and sub-

steps in a task, process, or workflow. Level 1 text corresponds to  
the top horizontal shapes, and Level 2 text corresponds to vertical 

sub-steps under each related top-level shape. 

 

Random to 

Result 

Process 

Use to show, through a series of steps, how several chaotic ideas 

can result in a unified goal or idea. Supports multiple items of 

Level 1 text, but the first and last Level 1 corresponding shapes 

are fixed. Works best with small amounts of Level 1 text and 

medium amounts of Level 2 text. 
 

Repeating 

Bending 

Process  

Use to show a progression or sequential steps in a task, process, 

or workflow. Maximizes both horizontal and vertical display space 

for shapes. 

 

Segmented 

Process 

Use to show a progression or sequential steps in a task, process, 

or workflow. Emphasizes Level 2 text, since each line appears in a 

separate shape. 

 

Staggered 

Process 

Use to show a downward progression through stages. Each of the 

first five lines of Level 1 text corresponds with a rectangle. 

Unused text does not appear, but remains available if you switch 

layouts. 

 

Step Down 

Process 

Use to show a descending process with multiple steps and sub-

steps. Works best with small amounts of text. 
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Step Up 

Process 

Use to show an ascending series of steps or lists of information. 

 

Sub-Step 

Process 

Use to show a multi-step process with sub-steps between each 

instance of Level 1 text. Works best with small amounts of text 

and is limited to seven Level 1 steps. Each Level 1 step can have 

unlimited sub-steps. 

 

Timeline Pipe Use to show sequential steps in a task, process, or workflow, or to 

show timeline information. Level 1 text appears larger than Level 

2 text. 

 

Upward 

Arrow 

Use to show a progression or steps that trend upward in a task, 

process, or workflow. Each of the first five lines of Level 1 text 
corresponds to a point on the arrow. Works best with minimal 

text. Unused text does not appear, but remains available if you 

switch layouts. 
 

Vertical 

Arrow List 

Use to show a progression or sequential steps in a task, process, 

or workflow that move toward a common goal. Works well for 

bulleted lists of information. 

 

Vertical 

Bending 

Process 

Use to show a progression or sequential steps in a task, process, 

or workflow. Maximizes both horizontal and vertical display space 

for shapes. Places more emphasis on the interrelationships among 

the shapes than on direction or movement. 

 

Vertical 

Chevron List 

Use to show a progression or sequential steps in a task, process, 

or workflow, or to emphasize movement or direction. Emphasizes 

Level 2 text over Level 1 text, and is a good choice for large 
amounts of Level 2 text. 

 

Vertical 

Equation 

Use to show sequential steps or tasks that depict a plan or result. 

The last Level 1 line of text appears after the arrow. Works best 

with Level 1 text only. 

 

Vertical 

Process 

Use to show a progression or sequential steps in a task, process, 

or workflow from top to bottom. Works best with Level 1 text, 
since the vertical space is limited. 
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Cycle 

Layout name Description Picture 

Basic Cycle Use to represent a continuing sequence of stages, tasks, or events 

in a circular flow. Emphasizes the stages or steps rather than the 
connecting arrows or flow. Works best with Level 1 text only. 

 

Basic Pie Use to show how individual parts form a whole. The first seven lines 

of Level 1 text correspond to the evenly distributed wedge or pie 

shapes. The top Level 1 text shape appears outside of the rest of 

the pie for emphasis. Unused text does not appear, but remains 

available if you switch layouts. 

 

Basic Radial Use to show the relationship to a central idea in a cycle. The first 

line of Level 1 text corresponds to the central shape, and its Level 2 
text corresponds to the surrounding circular shapes. Unused text 

does not appear, but remains available if you switch layouts. 

 

Block Cycle Use to represent a continuing sequence of stages, tasks, or events 

in a circular flow. Emphasizes the stages or steps rather than the 

connecting arrows or flow. 

 

Circle Arrow 
Process 

Use to show sequential items with supporting text for each item. 
This diagram works best with small amounts of Level 1 text. 

 

Continuous 

Cycle 

Use to represent a continuing sequence of stages, tasks, or events 

in a circular flow. Emphasizes the connection between all 

components. Works best with Level 1 text only. 

 

Cycle Matrix Use to show the relationship to a central idea in a cyclical 

progression. Each of the first four lines of Level 1 text corresponds 

to a wedge or pie shape, and Level 2 text appears in a rectangular 

shape to the side of the wedge or pie shape. Unused text does not 

appear, but remains available if you switch layouts. 
 

Diverging 

Radial 

Use to show relationships to a central idea in a cycle. The first Level 

1 line of text corresponds to the central circular shape. Emphasizes 
the surrounding circles rather than the central idea. Unused text 

does not appear, but remains available if you switch layouts. 
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Gear Use to show interlocking ideas. Each of the first three lines of Level 

1 text corresponds to a gear shape, and their corresponding Level 2 

text appears in rectangles next to the gear shape. Unused text does 

not appear, but remains available if you switch layouts.  

 

Multidirectional 

Cycle 

Use to represent a continuing sequence of stages, tasks, or events 

that can occur in any direction. 

 

Nondirectional 

Cycle 

Use to represent a continuing sequence of stages, tasks, or events 

in a circular flow. Each shape has the same level of importance. 

Works well when direction does not need to be indicated. 

 

Radial Cluster Use to show data that relates to a central idea or theme. The top 

Level 1 text appears in the center. Level 2 text appears in 
surrounding shapes. Can contain up to seven Level 2 shapes. 

Unused text does not appear, but remains available if you switch 

layouts. Works best with small amounts of text. 
 

Radial Cycle Use to show the relationship to a central idea. Emphasizes both 

information in the center circle and how information in the outer 

ring of circles contributes to the central idea. The first Level 1 line of 

text corresponds to the central circle, and its Level 2 text 

corresponds to the outer ring of circles. Unused text does not 
appear, but remains available if you switch layouts.  

Radial Venn Use to show both overlapping relationships and the relationship to a 

central idea in a cycle. The first line of Level 1 text corresponds to 

the central shape and the lines of Level 2 text correspond to the 

surrounding circular shapes. Unused text does not appear, but 

remains available if you switch layouts.  
 

Segmented 

Cycle 

Use to show a progression or a sequence of stages, tasks, or events 

in a circular flow. Emphasizes the interconnected pieces. Each of the 
first seven lines of Level 1 text corresponds to a wedge or pie 

shape. Unused text does not appear, but remains available if you 

switch layouts. 
 

Text Cycle Use to represent a continuing sequence of stages, tasks, or events 

in a circular flow. Emphasizes the arrows or flow rather than the 

stages or steps. Works best with Level 1 text only. 

 

Hierarchy 

Layout name Description Picture 

Architecture 

Layout 

Use to show hierarchical relationships that build from the 

bottom up. This layout works well for showing 
architectural components or objects that build on other 
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objects. 

Circle Picture 

Hierarchy 

Use to show hierarchical information or reporting 

relationships in an organization. Pictures appear in circles 

and corresponding text appears next to the pictures.  

 

Half Circle 

Organization 

Chart 

Use to show hierarchical information or reporting 

relationships in an organization. The assistant shapes 

and Org Chart hanging layouts are available with this 
layout. 

 

Hierarchy Use to show hierarchical relationships progressing from 

top to bottom. 

 

Hierarchy List Use to show hierarchical relationships progressing across 
groups. Can also be used to group or list information. 

 

Horizontal 

Hierarchy 

Use to show hierarchical relationships progressing 

horizontally. Works well for decision trees. 

 

Horizontal 

Labeled 

Hierarchy 

Use to show hierarchical relationships progressing 

horizontally and grouped hierarchically. Emphasizes 

heading or level 1 text. The first line of Level 1 text 

appears in the shape at the beginning of the hierarchy, 

and the second and all subsequent lines of Level 1 text 

appear at the top of the tall rectangles.  

Horizontal 
Multi-Level 

Hierarchy 

Use to show large amounts of hierarchical information 
progressing horizontally. The top of the hierarchy is 

displayed vertically. This layout supports many levels in 

the hierarchy. 

 

Horizontal 

Organization 

Chart 

Use to show hierarchical information horizontally or 

reporting relationships in an organization. The assistant 

shape and the Org Chart hanging layouts are available 

with this layout. 

 

Labeled 

Hierarchy 

Use to show hierarchical relationships progressing from 

top to bottom and grouped hierarchically. Emphasizes 

heading or level 1 text. The first line of Level 1 text 

appears in the shape at the beginning of the hierarchy, 

and all subsequent lines of Level 1 text appear to the left 

of the tall rectangles.  
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Lined List Use to show large amounts of text divided into 

categories and subcategories. Works well with multiple 

levels of text. Text at the same level is separated by 

lines. 

 

Name and Title 

Organization 

Chart  

Use to show hierarchical information or reporting 

relationships in an organization. To enter text in the title 

box, type directly in the smaller rectangular shape. The 

assistant shape and Org Chart hanging layouts are 
available with this layout. 

 

Organization 

Chart  

Use to show hierarchical information or reporting 

relationships in an organization. The assistant shape and 

the Org Chart hanging layouts are available with this 

layout. 

 

Picture 

Organization 
Chart 

Use to show hierarchical information or reporting 

relationships in an organization, with corresponding 
pictures. The assistant shape and the Org Chart hanging 

layouts are available with this layout. 

 

Table Hierarchy Use to show groups of information built from top to 

bottom, and the hierarchies within each group. This 

layout does not contain connecting lines.  

 

Relationship 

Layout name Description Picture 

Arrow Ribbon Use to show either related or contrasting concepts with some 

connection, such as opposing forces. The first two lines of Level 1 
text are used for text in the arrows. Unused text does not appear, 

but remains available if you switch layouts.  

 

Balance Use to compare or show the relationship between two ideas. Each 

of the first two lines of Level 1 text corresponds to text at the top 

of one side of the center point. Emphasizes Level 2 text, which is 

limited to four shapes on each side of the center point. The balance 

tips towards the side with the most shapes containing Level 2 text. 
Unused text does not appear, but remains available if you switch 

layouts.  
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Basic Pie Use to show how individual parts form a whole. The first seven 

lines of Level 1 text correspond to the evenly distributed wedge or 

pie shapes. The top Level 1 text shape appears outside of the rest 

of the pie for emphasis. Unused text does not appear, but remains 

available if you switch layouts. 

 

Basic Radial Use to show the relationship to a central idea in a cycle. The first 

line of Level 1 text corresponds to the central shape, and its Level 

2 text corresponds to the surrounding circular shapes. Unused text 

does not appear, but remains available if you switch layouts. 

 

Basic Target Use to show containment, gradations, or hierarchical relationships. 

The first five lines of Level 1 text are associated with a circle. 

Unused text does not appear, but remains available if you switch 

layouts. 

 

Basic Venn Use to show overlapping or interconnected relationships. The first 

seven lines of Level 1 text correspond with a circle. If there are 

four or fewer lines of Level 1 text, the text is inside the circles. If 

there are more than four lines of Level 1 text, the text is outside of 
the circles. Unused text does not appear, but remains available if 

you switch layouts.  

Circle 

Relationship 

Use to show the relationship to or from a central idea. Level 2 text 

is added non-sequentially and is limited to five items. There can 

only be one Level 1 item. 

 

Continuous 
Picture List 

Use to show groups of interconnected information. The circular 
shapes are designed to contain pictures. 

 

Converging 

Arrows 

Use to show ideas or concepts that converge to a central point. 

Works best with Level 1 text only. 

 

Converging 

Radial 

Use to show relationships of concepts or components to a central 

idea in a cycle. The first line of Level 1 text corresponds to the 

central circular shape and the lines of Level 2 text correspond to 

the surrounding rectangular shapes. Unused text does not appear, 

but remains available if you switch layouts.  
 

Counterbalance 

Arrows 

Use to show two opposing ideas or concepts. Each of the first two 

lines of Level 1 text corresponds to an arrow and works well with 
Level 2 text. Unused text does not appear, but remains available if 

you switch layouts. 
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Cycle Matrix Use to show the relationship to a central idea in a cyclical 

progression. Each of the first four lines of Level 1 text corresponds 

to a wedge or pie shape, and Level 2 text appears in a rectangular 

shape to the side of the wedge or pie shape. Unused text does not 

appear, but remains available if you switch layouts. 
 

Diverging 

Arrows 

Use to show ideas or concepts that progress outward from a central 

source. Works best with Level 1 text only. 

 

Diverging Radial Use to show relationships to a central idea in a cycle. The first 

Level 1 line of text corresponds to the central circular shape. 

Emphasizes the surrounding circles rather than the central idea. 

Unused text does not appear, but remains available if you switch 

layouts. 
 

Equation Use to show sequential steps or tasks that depict a plan or result. 

The last Level 1 line of text appears after the equals sign 
(=).Works best with Level 1 text only. 

 

Funnel Use to show the filtering of information or how parts merge into a 

whole. Emphasizes the final outcome. Can contain up to four lines 

of Level 1 text; the last of these four Level 1 text lines appears 

below the funnel and the other lines correspond to a circular shape. 

Unused text does not appear, but remains available if you switch 
layouts.  

Gear Use to show interlocking ideas. Each of the first three lines of Level 

1 text corresponds to a gear shape, and their corresponding Level 

2 text appears in rectangles next to the gear shape. Unused text 

does not appear, but remains available if you switch layouts. 

 

Grouped List Use to show groups and sub-groups of information, or steps and 

sub-steps in a task, process, or workflow. Level 1 text corresponds 
to the top-level horizontal shapes, and Level 2 text corresponds to 

vertical sub-steps under each related top-level shape. Works well 

for emphasizing sub-groups or sub-steps, hierarchical information, 

or multiple lists of information.  

Hierarchy List Use to show hierarchical relationships progressing across groups. 

Can also be used to group or list information. 

 

Linear Venn Use to show overlapping relationships in a sequence. Works best 

with Level 1 text only. 
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Nested Target Use to show containment relationships. Each of the first three lines 

of Level 1 text correspond to the upper left text in the shapes, and 

Level 2 text corresponds to the smaller shapes. Works best with 

minimal Level 2 lines of text. Unused text does not appear, but 

remains available if you switch layouts.  
 

Nondirectional 

Cycle 

Use to represent a continuing sequence of stages, tasks, or events 

in a circular flow. Each shape has the same level of importance. 

Works well when direction does not need to be indicated. 

 

Opposing 

Arrows 

Use to show two opposing ideas, or ideas that diverge from a 

central point. Each of the first two lines of Level 1 text corresponds 

to an arrow. Unused text does not appear, but remains available if 

you switch layouts. 

 

Picture Accent 

List 

Use to show grouped or related information. The small shapes on 

the upper corners are designed to contain pictures. Emphasizes 
Level 2 text over Level 1 text, and is a good choice for large 

amounts of Level 2 text. 

 

Radial Cluster Use to show data that relates to a central idea or theme. The top 

Level 1 text appears in the center. Level 2 text appears in 

surrounding shapes. Can contain up to seven Level 2 shapes. 

Unused text does not appear, but remains available if you switch 

layouts. Works best with small amounts of text. 
 

Radial Cycle Use to show the relationship to a central idea. Emphasizes both 

information in the center circle and how information in the outer 

ring of circles contributes to the central idea. The first Level 1 line 

of text corresponds to the central circle, and its Level 2 text 

corresponds to the outer ring of circles. Unused text does not 

appear, but remains available if you switch layouts.  

Radial List Use to show relationships to a central idea in a cycle. The center 

shape can contain a picture. Level 1 text appears in the smaller 
circles and any related Level 2 text appears to the side of the  

smaller circles.  

 

Radial Venn Use to show both overlapping relationships and the relationship to 

a central idea in a cycle. The first line of Level 1 text corresponds 

to the central shape and the lines of Level 2 text correspond to the 

surrounding circular shapes. Unused text does not appear, but 

remains available if you switch layouts.  
 

Segmented 

Pyramid 

Use to show containment, proportional, or interconnected 

relationships. The first nine lines of Level 1 text appear in the 

triangular shapes. Unused text does not appear, but remains 

available if you switch layouts. Works best with Level 1 text only. 
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Stacked Venn Use to show overlapping relationships. A good choice for 

emphasizing growth or gradation. Works best with Level 1 text 

only. The first seven lines of Level 1 text correspond to a circular 

shape. Unused text does not appear, but remains available if you 

switch layouts. 
 

Table Hierarchy Use to show groups of information built from top to bottom, and 

the hierarchies within each group. This layout does not contain 

connecting lines.  

 

Target List Use to show interrelated or overlapping information. Each of the 

first seven lines of Level 1 text appears in the rectangular shape. 

Unused text does not appear, but remains available if you switch 

layouts. Works well with both Level 1 and Level 2 text. 

 

Vertical 

Equation 

Use to show sequential steps or tasks that depict a plan or result. 

The last Level 1 line of text appears after the arrow. Works best 
with Level 1 text only. 

 

Matrix 

Layout 

name 

Description Picture 

Basic 

Matrix 

Use to show the relationship of components to a whole in quadrants. The 

first four lines of Level 1 text appear in the quadrants. Unused text does not 

appear, but remains available if you switch layouts. 

 

Cycle 
Matrix 

Use to show the relationship to a central idea in a cyclical progression. Each 
of the first four lines of Level 1 text corresponds to a wedge or pie shape, 

and Level 2 text appears in a rectangular shape to the side of the wedge or 

pie shape. Unused text does not appear, but remains available if you switch 

layouts. 
 

Grid 

Matrix 

Use to show the placement of concepts along two axes. Emphasizes the 

individual components rather than the whole. The first four lines of Level 1 

text appear in the quadrants. Unused text does not appear, but remains 

available if you switch layouts. 

 

Titled 

Matrix 

Use to show the relationships of four quadrants to a whole. The first line of 

Level 1 text corresponds to the central shape, and the first four lines of 

Level 2 text appear in the quadrants. Unused text does not appear, but 

remains available if you switch layouts.  
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Pyramid 

Layout name Description Picture 

Basic 

Pyramid 

Use to show proportional, interconnected, or hierarchical relationships 

with the largest component on the bottom and narrowing up. Level 1 
text appears in the pyramid segments and Level 2 text appears in 

shapes alongside each segment. 

 

Inverted 

Pyramid 

Use to show proportional, or interconnected, or hierarchical 

relationships with the largest component on the top and narrowing 

down. Level 1 text appears in the pyramid segments and Level 2 text 

appears in shapes alongside each segment. 

 

Pyramid List Use to show proportional, interconnected, or hierarchical relationships. 
Text appears in the rectangular shapes on top of the pyramid 

background. 

 

Segmented 

Pyramid 

Use to show containment, proportional, or interconnected 

relationships. The first nine lines of Level 1 text appear in the 

triangular shapes. Unused text does not appear, but remains available 

if you switch layouts. Works best with Level 1 text only. 

 

Picture 

Layout name Description Picture 

Accented Picture Use to show a central, photographic idea with related ideas on the 
side. The top Level 1 text appears over the central picture. 

Corresponding text for other Level 1 shapes appear next to the 

small circular pictures. This layout also works well with no text. 

 

Alternating 

Picture Blocks 

Use to show a series of pictures from top to bottom. Text appears 

alternately on the right or left of the picture. 

 

Alternating 

Picture Circles 

Use to show a set of pictures with text. The corresponding text 

appears in the central circles with the images alternating from left 

to right. 

 

Ascending Picture 

Accent Process 

Use to show an ascending series of pictures with descriptive text. 

Works best with a small amount of text. 
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Bending Picture 

Accent List 

Use to show non-sequential or grouped blocks of information. The 

small circular shapes are designed to contain pictures. Works well 

for illustrating both Level 1 and Level 2 text. Maximizes both 

horizontal and vertical display space for shapes. 

 

Bending Picture 

Blocks 

Use to show a series of pictures. The box covering the bottom 

corner can contain small amounts of text. 

 

Bending Picture 

Caption 

Use to show a sequential series of pictures. The box covering the 

bottom corner can contain small amounts of text. 

 

Bending Picture 

Caption List 

Use to show a series of pictures. The title and description appear 

in a callout shape under each picture. 

 

Bending Picture 

Semi-

Transparent Text 

Use to show a series of pictures. A semi-transparent box covers 

the lower portion of the picture and contains all levels of text. 

 

Bubble Picture 

List 

Use to show a series of pictures. Can contain up to eight Level 1 

pictures. Unused text and pictures do not appear, but remain 

available if you switch layouts. Works best with small amounts of 

text. 

 

Captioned 

Pictures 

Use to show a picture with multiple levels of text. Works best with 

a small amount of Level 1 text and a medium amount of Level 2 

text. 

 

Circle Picture 

Hierarchy 

Use to show hierarchical information or reporting relationships in 

an organization. Pictures appear in circles and corresponding text 

appears next to the pictures. 

 

Circular Picture 

Callout 

Use to show a central idea and sub-ideas or related items. The 

text for the first picture covers the lower portion of the picture. 
The corresponding text for other Level 1 shapes appears next to 

the small circular pictures. This diagram also works well with no 

text. 
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Continuous 

Picture List 

Use to show groups of interconnected information. The circular 

shapes are designed to contain pictures. 

 

Framed Text 

Picture 

Use to show pictures with corresponding Level 1 text displayed in 

a frame. 

 

Hexagon Cluster Use to show pictures with associated descriptive text. Small 

hexagons indicate the picture and text pair. Works best with small  

amounts of text. 

 

Horizontal Picture 

List 

Use to show non-sequential or grouped information with an 

emphasis on related pictures. The top shapes are designed to 
contain pictures. 

 

Picture Accent 

Blocks 

Use to show a group of pictures in blocks starting from the corner. 

The corresponding text displays vertically. Works well as an 

accent on title or sub-title slides or for section breaks of a 

document. 

 

Picture Accent 

List 

Use to show grouped or related information. The small shapes on 

the upper corners are designed to contain pictures. Emphasizes 

Level 2 text over Level 1 text, and is a good choice for large 

amounts of Level 2 text. 

 

Picture Accent 

Process 

Use to show sequential steps in a task, process, or workflow. The 

rectangular shapes in the background are designed to contain 

pictures. 

 

Picture Caption 

List 

Use to show non-sequential or grouped blocks of information. The 

top shapes are designed to contain pictures and pictures are 

emphasized over text. Works well for pictures with short text 

captions. 

 

Picture Grid Use to show pictures laid out on a square grid. Best with a small 

amount of Level 1 text, which appears above the picture. 
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Picture Lineup Use to show a series of pictures side by side. Level 1 text covers 

the top of the picture. Level 2 text appears below the picture. 

 

Picture Strips Use to show a series of pictures from top to bottom with Level 1 

text beside each. 

 

Snapshot Picture 

List 

Use to show pictures with explanatory text. Level 2 text can 

display lists of information. Works well with a large amount of 

text. 

 

Spiral Picture Use to show a series of up to five pictures with corresponding 

Level 1 captions that spiral in to the center. 

 

Titled Picture 

Accent List 

Use to show lists of information with an accent picture for each 

Level 2 text. Level 1 text displays in a separate box at the top of 

the list. 

 

Title Picture 

Lineup 

Use to show a series of pictures that each have their own title and 

description. Level 1 text appears in the box above the picture. 

Level 2 text appears below the picture. 

 

Titled Picture 

Blocks 

Use to show a series of pictures. Level 1 text appears above each 

picture. Level 2 text appears to the side and slightly overlapping 

each picture. 

 

Vertical Picture 

Accent List 

Use to show non-sequential or grouped blocks of information. The 

small circles are designed to contain pictures. 

 

Vertical Picture 

List 

Use to show non-sequential or grouped blocks of information. The 

small shapes on the left are designed to contain pictures. 
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Create a SmartArt graphic  

On the Insert tab, in the Illustrations group, click SmartArt.  

 

 

 

The SmartArt dialogue box will display. Click the type and layout that you want. 

Enter text 

Enter your text by doing one of the following: 

✓ Click Text in the Text pane, and then type your text.  

✓ Copy text from another location or program, click Text in the Text pane, and 

then paste your text. 
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✓ If the Text pane doesnot display, click the control 

 

 

 

 

 

 

 

 

 

 

 

 

OR 

✓ Click in a box in the SmartArt graphic, and then type your text.  

Tip For best results, use this option after you add all of the boxes 

that you want. 

Note To add text close to or on top of your SmartArt graphic, insert a text 
box and add your text 

Add shapes in your SmartArt graphic 

✓ Click the SmartArt graphic that you want to add another shape to. 

✓ Click the existing shape that is located closest to where you want to add the 

new shape. 
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✓ SmartArt Tools will display 

 

 

 

 

 

 

 

 

 

✓ Go to the Design tab Create Graphic group, and click the arrow under Add 
Shape. 

 

 

 

 

 

 

 

 

 

✓ To insert a shape after the selected shape, click Add Shape After. 

✓ To insert a shape before the selected shape, click Add Shape Before. 

✓ To add a shape from the Text pane, click an existing shape, move your cursor 

before or after the text where you want to add the shape, and then press 

ENTER. 

 

Note If you don't see the SmartArt Tools or Design tabs, make sure 

that you've selected the SmartArt graphic. You may have to 

double-click the SmartArt graphic to open the Design tab. 

Delete shapes in your SmartArt graphic 
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✓ To delete a shape from your SmartArt graphic, click the shape you want to 

delete, and then press DELETE.  

✓ To delete your entire SmartArt graphic, click the border of your SmartArt 

graphic, and then press DELETE. 
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Change the colours  

Using colours and colour effects 

With PowerPoint y are able to apply color variations that are derived from the theme 

colours to the shapes in your SmartArt graphic. 

You will use colours to enhance the message in your presentations: for example, for 

different steps in a process, you could give each step a different colour by applying 

Colourful - Accent Colors. 

 

Or you could use a colour gradient to stress the direction of your message for a linear 

process. 

 

You can create an effect of gradually changing color by applying a gradient to an 
object, so that its color varies smoothly from a darker to a lighter shade. Or, you can 

also use a gradient to give the shapes in your graphic a rainbow effect. 

Colour thumbnails 

Colour thumbnails show the different ways colors are applied (such as, alternating, or 

darkest to lightest), instead of how colors are used.  

Themes 

Tip A theme is a set of unified design elements that gives your 

document a specific look through using colour, font and 

graphics. 
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We can therefore say that a theme is made up of theme colours, theme fonts and 

theme effects, where theme colours are a set of colours used in a file. 

If you change the document theme, your SmartArt graphic will also reflect the new 

theme colors 
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Change colours 

✓ Click your SmartArt graphic. SmartArt Tools will display 

✓ Go to the Design tab, SmartArt Styles group and click Change Colors.  

 

✓ Click to select the color variation that you need. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Apply a SmartArt Style 

A SmartArt Style combines various effects, to create a unique look for your SmartArt 

graphic.   Some of the effects are a bevelled effect or a 3-D effect. 

✓ Click your SmartArt graphic. SmartArt Tools will display 

✓ On the Design tab, in the SmartArt Styles group, click the SmartArt Style 

that you want. 

✓ To see more SmartArt Styles, click the More button .  



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 71 

 

Tip To resize your entire SmartArt graphic, click the border of your 

SmartArt graphic, and then drag the sizing handles in or out 

until your SmartArt graphic is the size that you want. 



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 72 

 

 

Change the color of a shape 

✓ Click the shape in the SmartArt graphic that you want to change. The 

SmartArt Tool will display 

✓ On the Format tab, in the Shape Styles group, click the arrow next to 

Shape Fill, and then click the color that you want.  

✓ To choose no color, click No Fill. 

 

 

✓ To change to a colour that is not in the theme colours, click More Fill Colors,  

✓ Then either click the colour that you want on the Standard tab, or mix your 

own color on the Custom tab.  

Note Custom colors and colors on the Standard tab are not 

updated if you later change the document theme 

 

 

✓ If you do not see the SmartArt Tools or Format tabs, make sure that you 

have selected a SmartArt graphic. You might have to double-click the shape to 

open the Format tab. 
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Tip If you want to change multiple shapes to the same coloor, 

click the first shape, and then press and hold CTRL while you 

click the other shapes. 
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Change the color of a shape border 

✓ Click the shape that has the border that you want to change.  The SmartArt 

Tools will display 

✓ On the Format tab, in the Shape Styles group, click the arrow next to 

Shape Outline, 

✓ Click the color that you want.  

Tip To hide the border, click No Outline.  

 

Tip If you want to change multiple shape borders to the same 

color, click the first shape, and then press and hold CTRL 

while you click the other shapes. 

Change the color of an entire SmartArt graphic 

✓ Click the SmartArt graphic to display the SmartArt Tool 

✓ Go to the SmartArt Styles group and click Change Colors 

✓ Click the thumbnail that you want. 
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Tip To see how a color will be applied to your SmartArt graphic 

before you select a thumbnail, place your pointer over the 

thumbnail that you want, and then look at your SmartArt 

graphic. 
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Create an Organisation Chart 
An organisation chart is a diagram showing how objects are related in a hierarchy. 

They are typically used to show levels of responsibility in a company or to show the 

hierarchy of personnel.  

To create an organisation chart 

✓ Select Insert New Slide and select a slide that in cludes the Illustrations 

grouping: 

 

 

✓ Click on Insert SmartArt graphic.  The SmartArt Graphic dialogue box will 

display 

 

 

 

 

✓ Select Hierarchy and then select Organisation Chart 
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An organisation chart will be added to your slide 

 

 

Add text to the Organisation Chart  

✓ Enter the name and job title of the person at the top of the organisation 

✓ Click in each box and enter the appropriate names and titles 

✓ To add a subordinate, select the box you want to add the subordinate to, click 

the Add Shape in the Create Graphic group 

 

Choose from the following: 

✓ To add more entries at the same level, select Add Shape before or after 

✓ Add Shape above to add a box one level above 

✓ To add a subordinate, select Add shape below 

✓ Select Add assistant to add an assistant 
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When you have finished, click outside of the chart area to embed the organisation 

chart into the document 

 

 

Tip You can also add elements by right-clicking in the box to 

which you want to add a subordinate or assistant. 

Modify the Structure of an Organisation Chart  

You can move and delete elements of the hierarchy, change the way subordinate 

elements are shown, and edit the data shown in the shapes.  

To edit organisation chart data 

✓ Left-click the organisation chart area to edit it 

✓ Click in the appropriate box and make the necessary changes 

✓ When you have finished making changes, click outside the organisation chart 

area 

To select a shape 

Before making any changes you need to select the shapes you wish to change. 

✓ To select one item, simply click on its border 

✓ To select several shapes, hold down the Shift  key while you click on the 

shapes you want to select 

To delete a shape 

You cannot delete a shape if it has assistants or subordinates attached to it. 

✓ Select the box you wish to remove and press the Delete  key  
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To change the layout of subordinate elements 

If a manager has many subordinate elements, you can change the layout to hanging 

to avoid making the chart too wide. 

✓ Select the Manager box for the group of boxes whose layout you want to 

change 

✓ On the Design tab, in the Create Graphic group, select Layout 

✓ The Layout options are displayed. Select the appropriate layout option 
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Format a Diagram or Organisation Chart 

Change the size  

To change the size of individual elements within a SmartArt graphic: 

✓ Go to the Format tab, Shapes group 

✓ Select Larger or Smaller 

To change the size of the entire SmartArt graphic, click and drag one of the corners 

Format text  

Text within a box can be formatted using the normal text formatting tools. If you 

select a shape (as opposed to text within the shape) any formats will be applied to all 

text within the shape. 

The tools to format text will be found on the Home tab 

Change the appearance of elements of anorganisation chart 

Diagram elements can be formatted using the normal shape formatting tools.  

✓ Left click the SmartArt graphic to edit it 

✓ Select the elements you wish to make changes to by clicking on them ( Shift

+click to select multiple elements) 

✓ To change the shape and edit shape styles, go to the Format tab 

✓ To change SmartArt styles, go to the Design tab of Smartart Tools 

Tip You are be able to change the line styles as well as the shape 

and colour 
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Formative Assessment 

✓ Create a new file based on the blank template 

✓ Insert a new diagram object 

✓ Create the organisation chart shown below 

 

 

 

✓ Save the file as ORG CHART and close it 

 

✓ Create a new file based on the blank template 

✓ Insert a new diagram object 

✓ Create the SmartArt shown below 
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✓ Save the file as DEVELOPMENT DIAGRAM and close it 
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CREATING A SIMPLE DRAWING 

 

 

 

Outcome  

Create a drawing in a presentation 

 

 

 

Assessment criteria 

✓ Lines are drawn into a presentation: Straight line, arrow line, curve line, 

freeform line 

✓ Line attributes are changed: Style, arrow start and finish, colour, width 

✓ Shapes are drawn into a presentation: At least two of: Box, circle, autoshape 

✓ The orientation of a drawing is changed 

✓ The attributes of a shape are changed: Any three of: line colour, fill colour, 3-D 

✓ Drawings are resized: Resize entire drawing 

✓ Drawing objects are re-aligned in the presentation: At least one of: 

automatically, manually 

✓ The order of display of overlapping objects is changed relative to the other 

drawing objects 

✓ Connector lines are added between shapes 
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Office comes with a standard set of line art drawing tools, allowing you to create 

drawings and custom diagrams or flowcharts in any of the Office applications. As well 

as basic shapes, such as lines, circles, and boxes, a collection of Shapes gives you 

access to more unusual shapes, such as stars, banners, and callouts. 

In PowerPoint, you can add objects directly over the slide/worksheet quite easily, 

without interfering with existing objects. However, to create a complex drawing, you 

may want to insert a drawing object to keep the shapes together. Doing this will make 

it easier to move and copy the drawing when it is complete. 

Draw a Basic Shape 

Create a drawing  

✓ Insert a blank slide 

✓ On the Insert tab, in the Illustrations group, select Shapes 

✓ Select the shape you need 

✓ Click and drag in your slide to draw the shape 

✓ Change the colour and line of the shape to suit your needs by going to the 

Format or Design tabs 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Draw a rectangle or oval 
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✓ Click on the Rectangle button  or the Oval button  and point to where 

you want to start the object 

The mouse pointer changes to a crosshair shape . 

✓ Click-and-drag to draw the object 

✓ Release the mouse button to finish the object 
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OR 

✓ Click to draw the object at a pre-set size, which will draw either a square or 

circle. 

✓ The object is drawn, and white handles are displayed at the corners of the 

object indicating that it is selected.  

 

 

 

 

 

 

Constraint keys 

When you draw shapes, you can hold down the Shift  key as well as the Ctrl  key to 

constrain how an object is drawn.  

To constrain lines and arrows 

✓ Hold down the Shift  key while you draw a line at 15° intervals 

✓ Hold down the Ctrl  key to draw a line extending from its midpoint out in both 

directions 

To constrain rectangles and ovals 

✓ Hold down the Shift  key while drawing to create perfect circles or perfect 

squares 

✓ Hold down the Ctrl  key to draw the object from the centre outwards 

Draw a shape 

✓ Click the Shape you want  

✓ Move the mouse pointer to where you want the object to start 

The pointer turns into a crosshair  when you move it onto the page. 

✓ Click-and-drag the mouse pointer to draw the object 

✓ Release the mouse button where you want the object to end 

OR  

✓ Click to draw the object at a preset size 
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Adjust a shape 

Many shapeses have adjustment handles you can use to adjust a unique aspect of the 

object. The adjustment handles are yellow diamond shapes and they are only visible 

when an object is selected. 

 

✓ Click on the adjustment handle with the adjustment pointer  and drag to 

resize 

Change an object to a different shape 

Most types of shape can be changed to a different AutoShape. 

✓ Select the shape  

✓ On the Format tab, Insert Shapes group go to Edit Shape 

✓ Select Change Shape 

✓ The Shapes dialogue box will display 

✓ Select the shape you need 

 

 

 

 

 

 

 

 

 

Draw a line or arrow 

✓ Insert a blank slide 

✓ On the Insert tab, in the Illustrations group, select Shapes 

 

Adjustment 
handle 
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✓ Click the Line button  or the Arrow button  then point to where you 

want to start the line 

The mouse pointer changes to a cross-hair shape . 

✓ Click-and-drag the mouse pointer to draw the object 

✓ Release the mouse button to finish the line 

The line is drawn, and white handles are displayed at the ends of the object indicating 

the object is selected.  

 
Selected arrow shape 

Draw a curve or freeform line 

As well as straight lines and basic shapes, you can use the drawing tools to create 

irregular shapes, freehand lines, and curves. 

✓ Select Lines and uUse the following tools to draw different types of line: 

To draw freehand, as though the mouse were a pen, click the Scribble tool  

✓ Click-and-drag to draw the line, releasing the mouse button to finish 

To draw a smooth, curving line, click the Curve tool   

✓ Click to start the line, move the mouse then click again to add a bend in the line 

✓ Add further curves if you wish, then double-click to end the line 

The Freeform tool  combines the actions of the Line  and Scribble  tools. 

Use it to draw an object that has both curved and straight segments. 

✓ Click the Freeform tool  

✓ Click the mouse to start the line then EITHER click to add straight lines to the 

shape OR click-and-drag to add freehand segments 

✓ Double-click to complete the shape 

Tip Using any of the above tools, if you close a shape by ending the 

line at the same point it starts, the shape will be filled with the 

default fill colour. 

 

Note Change the colour of the line to suit your needs by going to 

the Format or Design tabs 
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Add Text to an Object 
Rectangles, circles, triangles, and other closed shapes drawn with the AutoShapes tool 
can have text attached to the shape.  

Add text to a shape or a drawing 

✓ Select the shape then simply begin typing 

✓ In The text is added to the object. You can format the text using the normal 

tools. 

Note When you type in a shape, text is treated as part of the 

shape. When you move the shape, the text moves with it. 
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Adjust text boundaries and alignment in an AutoShape 

✓ Select the shape then from the Format menu, select AutoShape.... and click 

the Text Box tab 

 
Format AutoShape - Text Box tab (PowerPoint) 

 

✓ Use the Internal margin boxes to set the distance between text and the 

edges of the shape 

✓ In PowerPoint and Excel, set the vertical alignment of text in the shape using 

the Text anchor point: list box (make sure the Resize AutoShape to fit 
text option is de-selected for this to have any effect) 

✓ Click the Word wrap text in AutoShape check box to constrain text within 

the shape 

✓ Click the Rotate text within AutoShape by 90 check box to turn the text 

on its side 

✓ Click OK 

Formative Assessment 

✓ Create an organisation chart for the college or your place of work 

✓ Draw a logo for your house or draw any other picture.  You have to make use of 

at least two shapes and at least one type of line for your picture. 

✓ Add colours and effects to your chart and your picture 

 



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 92 

 

 

IMPORTING AND EXPORTING DATA 

 

 

 

Outcome  

Import images into a presentation 

 

 

 

Assessment criteria 

✓ Images are imported from different file types: File types: JPEG, WMF, BMP 

✓ Images are resized: Resize entire image, crop image 

✓ An image is copied to a master slide 
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You can include information in a presentation from many other sources. You can 

import pictures and clip art created with graphics applications. You can write the 

presentation in outline form in Word or any other word processor then use the file to 

generate a new presentation. You can also create embedded data objects, such as 

tables, graphs, organisation charts, or sound or video clips. 

Alternatively, you can use data from your PowerPoint presentation in other 

applications. For example, you could export a presentation to Word to create a report 

or handout. 

Insert or Paste an OLE Object 
Most Microsoft Windows applications allow data to be moved or copied to a different 
application. This is known as Object Linking and Embedding. You can import data 

using the Cut, Copy, and Paste tools (or the Office Clipboard) or create new objects 

using the Insert tab. A data object (OLE object) can either be saved as part of the 

PowerPoint file (embedded) or remain in its original file (linked). 

Linked objects are stored in the original file and edited using the original application. 

The PowerPoint presentation contains a pointer (or link) to the contents of the original 

file. You can open the object for editing by double-clicking it on the slide or by 
opening the original file through Windows Explorer. You can link an object using Paste 

Special or through Insert Object. 

Embedded objects become part of the PowerPoint presentation. Like linked objects 

they are edited by double-clicking the object. An object is embedded when you use 

the Cut, Copy, and Paste tools or through Insert Object. 

When you edit an object from PowerPoint by double-clicking, depending on the type of 

data, either PowerPoint's menus and toolbars will be replaced with those of the editing 

application or the object will be opened in an application window. 

Link an object using the Clipboard 

Tip These notes refer to linking or embedding an object from 

another application in PowerPoint. You can use the same 

steps starting from another Office application to export data 

from a PowerPoint presentation to another file. 

 

✓ Start the application in which you wish to create or edit the object 

✓ Open, edit, or create the file containing the data to include in the presentation 

✓ Select the data and copy it onto the Windows Clipboard 

✓ Switch to PowerPoint and move to where you wish to place the linked 

information 

✓ From the Home tab, select Paste Special... 

✓ Click the Paste link option button 
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✓ Optionally, select a format for the link (for example, as an object or as a 

hyperlink) 

✓ Click OK 

The object is pasted into the presentation. The AutoCorrect smart tag may be 

displayed to help you position the object in a placeholder. 

To embed an object using the Clipboard 

✓ Open, edit, or create the file containing the data to include in the presentation 

✓ Select the data and copy it onto the Windows Clipboard 

✓ Switch to PowerPoint and move to where you wish to place the linked 

information 

✓ From the Home tab, click Paste... 

The object is pasted into the presentation.  

To embed an object using Paste Special 

You can use Paste Special to embed an object in a different format. For example, if 

you select a Word table then use Paste Special in PowerPoint, you can choose to paste 

the table as HTML, as Word data, as a picture, as unformatted text, and so on. It is a 
good idea to experiment with the different options to see which will give you the best 

effect in terms of the appearance of the data and the ease of editing it.  

✓ Copy the data you want to use 

✓ From the Home tab, select Paste Special... 

✓ Select a data format from the As: box then click OK 
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Export Text and Slides to Microsoft Word 
PowerPoint slides, graphics, and objects can be copied, pasted, dragged, embedded, 

and linked from PowerPoint to a Word document. 

What are PDF and XPS formats? 

Portable Document Format (PDF) 

PDF preserves document formatting and enables file sharing. When the PDF format 
file is viewed online or printed, it retains the format that you intended. Data in the file 

cannot be easily changed, and can be explicitly set to prohibit editing. The PDF format 

is also useful for documents that will be reproduced using commercial printing 

methods. PDF is accepted as a valid format to many agencies and organizations, and 

viewers are available on a wider variety of platforms than XPS.  

XML Paper Specification (XPS) 

XPS is a platform-independent technology that also preserves document formatting 

and enables file sharing. When the XPS file is viewed online or printed, it retains 
exactly the format that you intended, and the data in the file cannot be easily 

changed. XPS embeds all fonts in the file so they appear as intended, regardless of 

whether the specified font is available on the recipient's computer, and has more 

precise image and color rendering on the recipient's computer than PDF. 

Edit or print PowerPoint handouts in Word 

You can print handouts from Microsoft PowerPoint 2010, but if you want to use the 

editing and formatting features of Microsoft Word, you can work on and print your 

handouts using Word. In the open presentation, do the following: 

✓ Click the File tab, then click Save & Send. 

✓ Under File Types, click Create Handouts, then 

under Create Handouts in Microsoft Word, 

click Create Handouts.  

✓ In the Send to Microsoft Office Word 

dialogue box, click the page layout that you 

want, and then do one of the following: 

✓ To paste content that you want to remain 

unchanged when the content in the original 

PowerPoint presentation is updated, click Paste, 

and then click OK. 

✓ To ensure that any updates that occur to the 

original PowerPoint presentation are reflected in 

the Word document, click Paste Link, and then 

click OK. 
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Save a presentation in pdf or xps 

✓ Click the File tab and then click Save As.  

✓ In the File Name box, enter a name for the file 

✓ In the Save as type list, click PDF (*.pdf) or XPS Document (*.xps). 

Notes 

✓ If the document requires high print quality, click Standard (publishing online 

and printing). 

✓ If the file size is more important than print quality, click Minimum size 

(publishing online). 

Embed a slide in a Word document 

You can drag a PowerPoint slide into a Word document, which will place an image of 

the slide into the document, together with the background colour and any objects that 

have been placed on the slide. 

✓ Arrange both PowerPoint and Word so that they appear on the screen side by 

side 

✓ In PowerPoint switch to Normal view and make sure that the slide you want 

to drag is visible 

✓ In Word make sure that the page you want the slide to appear on is visible 

✓ In PowerPoint, select the slide and on the Home tabr, click Copy  

✓ Switch to the Word document, and on the Home tabr, click Paste  

 

 

First slide of the presentation displayed in a Word document 

 

✓ When you double-click the slide, the presentation runs as a full-screen slide 

show; press Esc  to return to Word 

✓ To edit the presentation from within Word, right-click the slide 

✓ From the shortcut menu, select Presentation Object, then Edit 

✓ The PowerPoint toolbars and menus are displayed, allowing you to make 

changes to the presentation 

✓ To return to Word, click outside of the object frame surrounding the slide 
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Note Any changes that you make to the presentation using this 

method will only exist within the Word document; the 

original presentation will remain unchanged. 

 

Insert Slides from Other Presentations 
Use this feature to copy slides from other presentations into a new or existing 

presentation. 

✓ Display the slide that will precede the new slide you want to insert 

✓ From the Insert tabmenu, select New slide and then Reuse slides...  

 

 

 

 

 

The Reuse Slides task pane and dialogue box is displayed. 

 

 

✓ Click the Browse button to locate the presentation from which you want to 

copy the slide or slides 

OR 

✓ Click Open a PowerPoint File 

✓ From the dialogue box that is displayed, select the 

required slide show and click Open 

✓ The slide show will be displayed in the Reuse Slides 

task pane 
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✓ Click on the slide you want to copy and the slide will be copied to your current 

slide show 
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Tip If you right-click on any slide, a shortcut menu will be 

displayed, giving you the option of inserting only one slide or 

all the slides 

 

 

 

 

 

 

 

 

Copy Slides between Two Presentations 

Slide Sorter view and the Slide panel in Normal view, allow you to move and copy 

slides within a presentation. You can also use them to transfer slides between 

presentations, using the Windows Clipboard, Office Clipboard, or drag-and-drop.  

To copy a slide using the clipboard 

✓ Open the first presentation 

✓ In Normal view, select the slides you want to move or copy 

✓ On the Home tabr, click Cut  or Copy  as required 

✓ Open the second presentation in Normal view displaying the Slides panel 

To copy a slide using drag-and-drop 

✓ Open both presentations in Normal view 

✓ Display the two presentations side-by-side. 

✓ Select the slides you want to copy ( Ctrl +click to select multiple slides) 
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✓ Click-and-drag the selected slides to the point you want to insert them  

✓ By default slides are copied, to move a slide, right-click the slide and select 

Cut, then right click in the other presentation window, and select Paste) 

A vertical bar indicates where the slides will be inserted.  

✓ Release the mouse button when the bar is in the correct position 

The slides are copied to the new presentation.  

Note The slides are automatically reformatted using the Slide 

Master for the destination presentation.  

Click the Maximize button  on the presentation's title bar to restore the window 

Formative Assessment 

✓ Create a new presentation  

✓ Insert pictures in the presentation 

✓ Open the presentation PRODUCT LAUNCH 
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✓ Copy slides from this presentation to your current presentation 

✓ Send Handouts to Word 
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ARRANGING OBJECTS 

 

 

Outcome  

Images and objects are manipulated in presentation: Chart/graphs, organisational 

charts, drawing objects 

 

 

Assessment criteria 

✓ Images and objects are moved 

✓ Images and objects are copied 

✓ Images and objects are deleted 

✓ Images and objects are manipulated: Flip and rotate images 

 

 

 

 

 

 

 

 

 

 



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 105 

 

 

Arrange and Transform Objects 
Rather than line up objects manually, you can use tools to align and distribute objects 

relative to other objects or relative to the page or slide. This is more accurate than 

positioning shapes by eye.  

You can also transform many types of object. An example of a transformation is to flip 

an object upside down or rotate it through 900. 

Change the order of objects 

Objects are drawn in layers. The last object to be added appears in the top layer. If 

you move it over another object it will appear in front of it. You can change the order 

of any object to move it forward or back. 

 

✓ Select the object(s) that you want to move forward or back 

✓ On the Format tab in the Arrange group,  toolbar, select an option 

Bring Forward has two choices: Bring Forward will move the object forward one 

layer, while Bring to the Front will move the object to the front layer 

Send Backward also has two options: Send Back will move the object back one 

layer, while Send to the Back will move the object to the back (bottom) layer 

 

 

 

 

 

 

OR 

✓ Right-click the selected object(s) then select the order from the shortcut menu 

To align objects relative to one another 

Aligning objects by eye can be quite tricky and time-consuming. It is easier to use the 

Align and Distribute tools.  

✓ Select the objects to align by Shift -clicking them 

✓ On the Format tab in the Arrange Group, select Align 

✓ Select an align option from the list 

The objects are aligned along the edge you selected. 



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 106 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tip If you select more than two objects, you can choose to 

distribute them. This means that the space between each 

object will be equalised. 

 

Rotate or flip an object 

✓ Select the object then point to a green handle 

The mouse pointer changes shape to the rotate arrow . 

 

 

 

 

 

 

 

 

 

 

✓ Drag the handle to rotate the object 
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OR 

✓ Select the object you want to rotate then in the Arrange group, select Rotate 

 

 

 

 

 

 

 

 

 

✓ Select the option you need 

Create a Group of Objects 

Grouping objects enables you to treat multiple objects as a single object. For 

example, suppose you used the drawing tools to draw a window. Without grouping the 
objects that comprise the window moving or resizing the window is much harder. 

Grouping objects combines them so you can work with them as a single object. Even 

while objects are grouped together, the individual components of the group can still 

be formatted without having to ungroup the object first.  

 

  
Individual objects are grouped as 

one 

A drawing comprising many individual 

objects 

To group objects 

✓ Select the objects you want to group then on the Format tab, 

Arrange Group select Group  (or right-click the objects and 

select Group) 
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✓ Click on Group 
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Ungroup objects 

✓ Click on Ungroup  

To select an object within a group to change its formatting 

Formatting changes can be made to all objects within a group or to one particular 

object.  

✓ Click on the shape within the group that you want to format 

The selected shape appears with grey handles. 

✓ Format as required 

  
Centre square selected within the 

group 

Centre square within a group formatted 

differently 

Note You cannot change the layer order of grouped objects relative 
to one another. You must ungroup the objects, change their 

layer order, then regroup them. 

Move Images and objects (Cut-And-Paste) 
You can move or copy graphic objects on a slide and also between different slides. 

The procedure is the same in each case. 

The Clipboard is a temporary storage area used by Windows to hold text or graphics 
while it is being moved or copied. The Clipboard can be used to transfer information 

within an application such as PowerPoint, or between applications such as PowerPoint 

and Word. The information remains on the Clipboard until you replace it or until you 

exit from Windows. 

The terms used for these actions are Cut, Copy, and Paste.  

✓ Cut removes the information from an application and places it on the 

Clipboard. 

✓ Copy leaves the information in an application and places a copy of it on the 

Clipboard. 

✓ Paste copies the information from the Clipboard and places it into an 

application. 

PowerPoint also features an Office Clipboard that can be used to collect multiple items 

for pasting into Office applications. 

Move graphic objects 
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✓ Select the object to be moved 

On the Home tab, click Cut  (SpeedKey: Ctrl + X ) 
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The object is removed from the document and placed onto the Clipboard. The 

previous contents of the Windows Clipboard are removed. 

✓ Move the insertion point to the destination  

On the Home tab, click Paste  (SpeedKey: Ctrl + V ) 

The contents of the Clipboard are copied from the Clipboard to the destination. You 

can paste the contents of the Clipboard again. 

Tip Alternatively, after selecting the object, click the right mouse 

button and from the shortcut menu, select Cut, then right-

click where you want to put the text and select Paste. 
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Formative Assessment 

✓ Open the file VALENTINE in PowerPoint 

✓ By copying and arranging the objects, design a valentine card 

 

✓ You can add a message 
to the thought-bubble by 

right-clicking  

✓ Use the Group tool to 

"lock" objects when you 
have got them in a good 

configuration 

✓ Follow the design shown 

or make up your own if 

you prefer 

 

✓ Save and close the file 

✓ If you have time, open WINDOW in PowerPoint and try to recreate the window 

graphic shown by duplicating, resizing, arranging, and transforming the objects 

provided 
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ACTION SETTINGS 

 

 

Outcome  

Animation effects and transitions are applied or added to a presentation.  

 

 

 

Assessment criteria 

✓ Animation effects are applied to the presentation: At least 3 of the following: 

Animation effects, timing, sounds, sequence, automatic, manual 

✓ Slide transition effects and timing are added to a presentation: At least 2 of the 

following:Transition effects, timing, sounds, automatic, manual 
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Types of slide shows 
Most presentations are designed as something for the audience to look at while the 

presenter talks about whatever topic he is presenting. 

You can also use PowerPoint to create self-running shows. There are two types of self-

running show: non-interactive and interactive. 

Both types of show can be made to loop (that is, when the last slide is reached, the 

presentation returns to slide 1). 

Non-interactive shows 

A non-interactive show is one where slides and animations play automatically, based 

on slide timings and animation settings. An experienced presenter can use a non-
interactive show, letting PowerPoint advance slides automatically. Non-interactive 

shows are also used to play to an audience (for example, a show outlining the benefits 

and features of a new product). Such shows could include voice narration as well. 

Interactive shows 

Rather than having a presenter, it is possible to design a presentation that the 
audience browse themselves. You can add action settings to a show to build a user 

navigation system, using PowerPoint to create a sophisticated multimedia application.  

Such presentations are ideal for educational and informational applications.  

Action settings can also assist a presenter in ordinary presentations because they 

allow him to move between slides, run macros, open other documents, and so on. 

Set the Type of Slide Show 

To make a slide show self-running and/or looping, you use the Set Up Show dialogue 

box.  

To set up a slide show 

✓ From the Slide Show tab, select Set Up Slide Show. The Set Up Show 

dialogue box is displayed. 
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✓ To create an interactive show, from the Show type panel, select Browsed by 
an individual (window) or Browsed at a kiosk (full screen) 

The first option leaves toolbars on the screen for the user. You could create a custom 

toolbar to help with navigation. If you do not want the user to access the presentation 

file itself, you should choose the kiosk option. 

✓ Selecting a kiosk-type show automatically sets Loop continuously until 'Esc' 
- you can select this option for other types of show as well 

✓ To use slide timings, select the Using timings, if present 

This option advances the show to the next slide if timings have been defined for the 

slide. You can create a show that advances using a mixture of manual and timed 

settings.  

✓ Click OK 

 

Tip With the kiosk option, the show restarts after 5 minutes if 

there is no user input. 

Rehearse Slide Show Timings 

Whether you will be delivering a stand-up presentation or you want to create timings 

for a self-running show, you can use the Rehearse Timings tool to help to set slide 

timings. 

✓ From the Slide Show tab, select Rehearse Timings 
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Tip The amount of time you spend on each slide and you can save 

those timings to run the show automatically 

✓ Practise giving the presentation, using the Advance button on the Rehearsal 
toolbar to move between slides and effects 

 
Rehearsal toolbar 

Each time you move on to the next slide, the time the slide was displayed for is 

recorded. 

✓ At the end of the slide show, you can choose to save the timings to the 

presentation 

To modify or remove slide timings 

You can enter slide timings manually or remove or modify rehearsed timings. You can 

also specify whether a mouse click can be used to over-ride slide timings. 

✓ Display the presentation in Normal view then 

on the Transition tab, go to the Timing 

group 

 

 

 

✓ To prevent the slide from advancing on a mouse click, clear the On mouse 
click box 

Advance 

Pause Time on 
Slide 

Restart 
Slide 

Time on 
show 
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✓ To modify slide timings, adjust the value in the After box 

✓ To remove slide timings, clear the After check box 

✓ The new settings are applied directly to the selected slide. 

✓ Optionally, click Apply to All to apply the same settings to all other slides in 

the presentation 

Animation 
Animation is a great way to focus on important points, to control the flow of 

information, and to increase viewer interest in your presentation.  

You can apply animation effects to text or objects on individual slides, to text and 

objects on the slide master, or to placeholders on custom slide layout   

Some of the different kinds of animation effects in PowerPoint 2010: 

Entrance effects: effects when you start viewing the slide. For example, you can make 

an object fade gradually into focus, fly onto the slide from an edge, or bounce into 

view. 

Exit effects: effects just before the slide changes to the next one. These effects 

include making an object fly off of the slide, disappear from view, or spiral off of the 

slide. 

Emphasis effects: to emphasise your message.  Examples of these effects include 

making an object shrink or grow in size, change color, or spin on its center. 

PowerPoint allows you to use any animation by itself or to combine multiple effects 

together. For instance, you can make a line of text fly in from the left while it grows in 

size by applying a Fly In entrance effect and a Grow/Shrink emphasis effect to it.  
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Add animation 

✓ Select the text or object that you want to animate 

✓ Go to the Animations tab, the Animation group 

✓ Click an animation effect from the gallery.  

 

✓ click the More button for more options 

 

 

✓ To change how your selection text animates, click Effect Options and then 

click what you want the animation to do. 
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Note In the gallery, entrance effects icons are colored green, 

emphasis effects icons are colored yellow, and exit effects 

icons are colored red. 

 

Specify timing 

You can specify the start, duration, or delay timing for an animation on the 

Animations tab.  

✓ Go to the Animations tab, Timing group 

✓ click the arrow to the right of the Start menu and select the timing that you 

want 

OR 

Select the commands in the Duration or Delay dialogue boxes  

✓ To set the duration of how long the animation will run, in the Timing group, 

enter the number of seconds that you want in the Duration box. 

✓ To set a delay before the animation begins, in the Timing group, enter the 

number of seconds that you want in the Delay box. 

 

 

 

Set order for an animation 

✓ Select the animation that you want to reorder 

✓ Go to the Animations tab, the Timing group, 

✓ Under Reorder Animation, either select Move Earlier to make the animation 

occur before another animation in the list or select Move Later to make the 

animation occur after another animation in the list. 
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Test your animation effect 

✓ To view what you animation effect looks like, go to the Animations tab 

✓ In the Preview group, click Preview. 

 

Apply sound effects  

✓ You will apply sound effectson the Animations tab 

✓ Go to the Advanced Animation group and click 

Animation Pane.  

✓ The Animation Pane opens on the side of the workspace 

pane, showing the order, type and duration of animation 

effects applied to text or objects on a slide. 

 

 

 

 

✓ Locate the effect to which you want to add sound, click the down arrow and 

then click Effect Options. 

✓ On the Effect tab, under Enhancements, 
in the Sound box, click the arrow to open 

the list  

✓ Click a sound from the list, and then 

click OK.  
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Note The Effect Options dialog box displays different options, 

according to the type of animation selected. 
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OR 

✓ To add a sound from a file, click Other Sound from the list, locate the sound file 

that you want to use, and then click Open. 

Note When you click OK or Open, the slide plays a preview of the 

animation with the sound added.  

✓ To change the preview sound volume, click Sound and move the slider up 

or down. To turn off the preview sound, select the Mute check box. 

✓ To preview all the animation and sound applied to a slide, in the Animation 

Pane, click Play. 

 

 

 

 

 

 

Formative Assessment 

Open the presentation NEW SEASON PRODUCTS 

✓ Display the presentation in Normal Sorter view 

✓ Run the show using the rehearse timings tool 

✓ Set up the show to run using the slide timings 

✓ Remove all the slide timings 

✓ Add animation effects to the show 

✓ Add slide effects to the show 

✓ Save and close the presentation 



Compiled by: Sakhisisizwe Approved By: L.Levin 

This document is strictly confidential and may on no account be reproduced, copied or divulged 

without prior authorisation. 

 

Unit Standard 119078: Use a GUI-based word processor to enhance a document through the use of tables and 
columns 

Revision number Date revised Page number 

Rev 3 14/5/2016 Page 125 

 

 

MASTER SLIDES 

 

 

Outcome  

Master Slides are customised within a presentation 

 

 

Assessment criteria 

✓ An item is copied to a master slide: Item: Any one of drawing object, image, 

object 

✓ Formatting is changed: At least 4 of the following:Font, style, size, colour, 
alignment, bullets, numbering, line spacing, character spacing, headers, 

footers, background 
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What Is A Master Slide 

Note  A slide master is the main slide that stores information about 

the theme and layouts of a presentation 

 

slide master (slide master: The main slide that stores information about the theme 
and layouts of a presentation, including the background, color, fonts, effects, 

placeholder sizes, and positions.) 

It is important to keep the theme and layout of each slide similar: the background, 

cololur, fonts, effects, placeholders, etc. 

This is accomplished using master slides. 

 Every presentation has a Slide Master, which sets the defaults for text formatting in 

the placeholders. This is called Master Text. Master text is similar to a style in word 

processing - it sets the defaults for text and allows you to modify the appearance of 

text in the whole presentation by changing its attributes in just one place. 

The Slide Master contains placeholders for the title, bullet text, and for footers. 

You can use the Slide Master to set the defaults for: 

✓ Font type 

✓ Font size 

✓ Font colour 

✓ Bullet styles 

✓ Tabs, indents, alignment, and spacing 

✓ Size and position of placeholders 

✓ Slide background colour or picture 

✓ Default colour scheme 

You can also add objects to the master slide to have them appear on every slide. 
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The default masters are linked to the design templates installed with PowerPoint. If 

you modify a master, you can give it a new name so that you can re-use it later. 

When you want to make a change to the presentation that will affect all the slides in 
the presentation with a particular template applied, make the change on the Slide 

Master, rather than each individual slide. PowerPoint will then automatically update 

the existing slides in the presentation that use the same template.  

Tip If you want to display your company logo in the same 
position on every slide in the presentation, insert the logo on 

the Slide Master so that it appears automatically on all 

slides using that master. 

View The Slide Master  

✓ From the View tab, Master Views group, select Slide Master  

The Master view is displayed. 

 

✓ To return to the presentation, on the View tab click Close Master View 

Modify The Slide Master  

If you want the same piece of text to appear on every slide, use a text box to add text 

to the Slide Master.  

Do not add text to the placeholders on the Slide Master as these are only 

for setting formatting characteristics for the presentation.  

Note All the normal formatting and editing tools work in master 

view as they do in normal view.  
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You can insert any type of image, picture, chart, drawing, or other object on a master 

slide, but remember that this will normally be displayed on every slide in your 

presentation. 

Tip You should not add objects that are too distracting or they 

will overwhelm the normal slide content.  

You need to maximise the amount of room for the actual slide content, which is why 

logos and background graphics are normally placed in a corner or the slide edge. 

You can create and add objects using the normal tools onInsert tab 

Or you could use the Cut, Copy, and Paste tools to add objects and text from other 

slides, presentations, or files. 

✓ From the View tab, Master Views group, select Slide Master  

✓ Make any changes required (for example, change the master slide's background 

colour, add a logo, change the bullet characteristics, and so on) 

✓ On the Slide Master tab, click Close Master View to return to the slides in 

the presentation 

Tip To remove an object from the master, select it then press 

Delete .  

Slide Master tab 

The Slide Master tab is displayed automatically in Master view.   

 

✓ You can insert a placeholder: 
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✓ You can edit a theme by changing the theme colours, fonts or effects 

 

 

 

 

 

 

 

✓ You can also change the background of the presentation 

 

Formative assessment 

✓ Open the presentation NEW SEASON PRODUCTS 

✓ Change the font of the slide master to any font of your choice 

✓ Add a background to the slide master 

✓ Close the Slide Master to view your changes 
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Glossary 

Term Definition 

Action Button A graphic that performs an action when clicked, such as opening 

another file or playing a sound. 

Alignment The horizontal and/or vertical position of an object relative to its 

background. For example, text can be centred between the 

document margins. 

Animation A technique used to create the effect of objects moving onto and 

off the screen. 

Answer Wizard A tool to access the online help system. 

Ask A Question A tool to access the online help system. 

AutoRecover A tool for saving data automatically and restoring it in the event 

of application or computer failure. 

AutoShapes A series of predefined shapes available from the Drawing toolbar. 

Background 

Objects 

Text and objects added to a master slide and so appear on every 

slide based on the master. 

Bullet A symbol that precedes a paragraph, usually used to format a 

list. 

Clip Art A library of graphics, sound and video files for use in Office 

programs. 

Clipboard A temporary storage area for data as it is Cut, Copied and 

Pasted. 

Cursor Controlled by moving the mouse, the cursor (or mouse pointer) 

is used to select elements of the screen. 

Custom 

Animation Task 

Pane 

A task pane that enables you to create customised animation 

effects to apply to text and objects. 
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Term Definition 

Custom Show A slide show comprising two or more presentation files. 

Diagram A tool for creating standard diagrams, such as organisation 

charts or Venn diagrams. 

Drag-and-Drop Moving data using the mouse instead of the Clipboard. 

Embed Storing a data object created and edited using a different 

application to the file the object is stored in. 

Favorite A list of bookmark links to files and web pages for easy access. 

File Data stored on a disk. Files are associated with, and edited 

using, different applications. Different file types are identified by 

their icon and file extension. 

Find and Replace A tool for locating and selecting text in a file. The selection can 

optionally be replaced by different text.  

Folder A directory created on a disk in which to store files. 

Font The typeface (or appearance) of text.  

Format The appearance of text or objects. 

Format Painter A tool that allows you to copy formats from one selection to 

another. 

Graph An Office component application for creating and editing charts. 

Handouts Printed pages with each slide in a presentation represented as a 

miniature. 

Header/Footer Areas reserved for text and graphics that appear at the 

top/bottom of every page. 

Icon A graphic or graphic button representing a file or command. 

Import Transferring or copying data stored in one file to another. Data 

can be imported using the cut, copy and paste, drag-and-drop or 

Insert/Import commands. 

Indent The distance between the margin and the text. 
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Term Definition 

Insert Mode The normal typing mode. New characters are inserted before 

existing characters. 

Insertion Point The typing cursor, indicating where text will appear. 

Landscape Page orientation where the page is wider than it is tall. 

Line A row of text within a paragraph. 

Line Spacing White space between the lines in a paragraph, usually measured 

in multiples of line height. 

Link Storing a link to a file (or part of a file) within another file. 

Macro A sequence of actions recorded in the Visual Basic for 

Applications programming language. A macro can be replayed by 

pressing a key, toolbar button, menu option or action button. 

Margins The area between the edge of an object and the text within it. 

Master Slide See "Slide Master" and "Title Master". 

Meeting Minder PowerPoint feature to help run meetings by taking minutes and 

generating a list of action items. 

Multimedia A presentation containing sound and/or video along with text. 

Menu A list of related commands grouped under a heading. 

Merge Save changes made by a reviewer back to the original 

presentation. 

New Presentation 

Task Pane 

A task pane that enables you to create new presentations based 

on a template, or to open an existing presentation. 

Normal View In PowerPoint, a combined view showing the slide, outline, notes 

and thumbnails together. 

Notes Page View The view used to edit and format notes text. 

Object A unit of data that can be copied between different files and 

applications. Examples of objects include pictures, charts and 

tables. 
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Term Definition 

Office A suite of related Microsoft software applications, sharing a 

common design. 

Office Assistant An on-screen helper that allows you to ask questions and 

provides tips while working. 

Office Clipboard An extension to the Windows Clipboard allowing multiple items to 

be collected and pasted in Office applications. 

OLE Object Linking and Embedding. OLE allows different applications 
to share data. You can insert an OLE object or file in any other 

file created in an OLE-compliant application. The object can be 

edited from the destination file using the original application. An 
embedded object is saved as part of the destination file. A linked 

object is saved in the original file and can be edited from either 

file. 

Organisation 

Chart 

A series of linked boxes showing the relationships between 

elements in a hierarchy. 

Orientation The direction of an object, usually used to refer to the 

dimensions of a page (portrait or landscape) but also of the 

direction of text. 

Outline View Used to edit and organise a presentation. 

Package Create a file archive for the presentation so that it a slide show 

can be displayed on another computer. 

Paper Size The type of paper a document is printed on. UK standard paper 
size is A4 (8.27x11.69" or 21x29.7 cm). US standard paper size 

is Letter (8.5x11" or 21.59x27.94 cm). 

Paragraph A block of text ended by a carriage return.  

Paragraph 

Spacing 

White space between paragraphs, usually measured in points. 

Paste Special A way of pasting specific elements of copied data (such as just 

formatting or values) or pasting data in a specific format. 
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Term Definition 

Placeholder A holder for a type of object such as text, clip art or charts in a 

standard slide layout. Placeholders appear as faint dotted lines 

on the slide and contain identifying text, such as "Click to add 

text". 

Points Units of measurement relating to the height of text characters. 

Portrait Page orientation where the page is taller than it is wide. 

Presenter View Special view used where two monitors are available, allowing the 

presenter more control over the presentation. 

Preview To view a document as it will print. 

Recycle Bin A Windows feature to store deleted files temporarily in case they 

need to be undeleted. 

Redo/Repeat A tool for reversing the effect of Undo or repeating previous 

edits. 

Review Tools allowing multiple users to edit and comment on a 
presentation file but leaving the original author free to accept or 

reject changes. 

Sans-serif Fonts where the text has plain ends. 

Save Writing data entered into an application to a file on a disk. 

ScreenTip A yellow box displayed over the selected element indicating its 

function. 

Scroll Scroll bars allow you to view parts of a document that will not fit 

in the screen area. 

Serif Fonts where the text has curly feet. 

Slide  The basic unit or "page" in a presentation document. 

Slide Layout Task 

Pane 

A PowerPoint feature for adding new slides. The Slide Layout 

task pane contains 27 default slide layouts with different object 

placeholders and arrangements. 
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Term Definition 

Slide Master A slide controlling the format and placement of titles and text on 

all slides except Title Slides. 

Slide Show  A way of viewing a presentation. In this view the PowerPoint 
window is not visible; each slide occupies the complete screen 

area. 

Slide Sorter View A view where each slide in a presentation is displayed as a 

miniature. Slides cannot be edited in this view, but they can be 

deleted, moved and copied. 

Smart Tag A feature for modifying data. 

Spelling Checker A tool to check spelling in the document. The Office products use 
the same spelling tool, though some features are not available in 

all applications. The checker uses a custom dictionary to keep 

track of words that are correct but that it does not recognise. 

Status Bar A bar at the bottom of the window displaying information about 

the file and application. 

Symbol Non-alphanumeric characters. Symbols cannot be inserted using 

normal key strokes. 

Tab A hidden character used to advance text to a certain position. 
Tabs are inserted using the Tab key. The position of tabs is 

controlled by setting tab stops. 

Table An object in a file displaying information in a grid. Tables are 

divided into rows and columns; rows representing records and 

columns representing fields.  

Task Pane Part of the application window giving access to commonly-used 

commands. 

Taskbar A Windows feature for starting programs and switching between 

applications. 

Template A file that contains specific formatting, design and colour that is 

applied to a presentation. Templates give a presentation a 

consistent appearance. 
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Term Definition 

Title Master A slide controlling the format and placement of titles and 

subtitles on Title Slides. 

Toolbar A bar containing icon buttons for frequently-used commands. 

True Type Fonts designed to match printed output with the screen display. 

Typeover Mode The mode used to type over existing characters in a document. 

Undo A tool for reversing previous edits. 

View Different ways of looking at and editing a document. 

Web A collection of linked web page documents published on the 

internet. 

Window Every application runs in a window, controlled using the icons on 
its Title bar. Some applications, including PowerPoint, open 

multiple documents in separate windows. 

Windows Media 

Services 

Windows Server technologies to display multimedia over a 

network to multiple users. 

Wizard A series of dialogue boxes assisting the user in completing a 

particular task. 

WordArt An application that enables you to create special text effects, 

such as shaping and rotating. 

Zoom To view the document at a different size. 

 

 

 


